
Руководство к быстрому старту

Mandrakelinux 9.2

http://www.mandrakesoft.com



Руководство к быстрому старту: Mandrakelinux 9.2
Опубликовано 2004-04-01
Copyright © 2004 Mandrakesoft SA
Camille Bégnis, Christian Roy, Fabian Mandelbaum, Joël Pomerleau, Vincent Danen, Roberto Rosselli del

Turco, Stefan Siegel, Marco De Vitis, Alice Lafox, Fred Lepied, Nicolas Planel, Kevin Lecouvey, Christian
Georges, John Rye, Robert Kulagowski, Pascal Rigaux, Frédéric Crozat, Laurent Montel, Damien Chaumette,
Till Kamppeter, Guillaume Cottenceau, Jonathan Gotti, Christian Belisle, Sylvestre Taburet, Thierry Vignaud,
Juan Quintela, Pascal Lo Re, Kadjo N’Doua, Mark Walker, Roberto Patriarca, Patricia Pichardo Bégnis, Alexis
Gilliot, Arnaud Desmons, Wolfgang Bornath, Alessandro Baretta, Aurélien Lemaire, Daouda Lo, Florent
Villard, François Pons, Gwenole Beauchesne, Giuseppe Ghibò, Georg Halfas, Florin Grad, Joël Wardenski,
Denis Devedjian, Debora Rejnharc Mandelbaum, Stew Benedict, David Baudens, Jean-Michel Dault

Юридическое замечание

Данное руководство защищено правами интеллектуальной собственности MandrakeSoft. Разрешено копировать,
распространять и/или изменять данный документ согласно Лицензии Свободной Документации GNU (GNU Free
Documentation License), Версии 1.1 или любой более поздней, опубликованной Фондом Свободного Программного
Обеспечения (Free Software Foundation); неизменяемые разделы Разд. 1, тексты лицевых обложек приведены в списке ниже,
текстов задней обложки нет. Копия лицензии доступна на сайте GNU (http://www.gnu.org/licenses/fdl.html).
Тексты лицевых обложек:

MandrakeSoft Сентябрь 2003

http://www.mandrakesoft.com/

Copyright <9560> 1999, 2000, 2001, 2002, 2003 MandrakeSoft S.A. и MandrakeSoft Inc.

“Mandrake”, “Mandrake Linux” и “MandrakeSoft” являются зарегистрированными торговыми марками MandrakeSoft S.A.;
Linux является зарегистрированной торговой маркой Linus Torvalds; UNIX является зарегистрированной торговой маркой The
Open Group в Соединенных Штатах и других странах. Все остальные торговые марки и копирайты являются собственностью
своих владельцев.

Инструментарий, который использовался для создания данного руководства

Это руководство было написано в XML DocBook. Для управления набором всех входящих в проект файлов был использован
Borges (http://linux-mandrake.com/en/doc/project/Borges/). Исходные XML файлы обрабатывались в xsltproc, openjade и
jadetex с использованием таблицы стилей Norman Walsh. Снимки экрана были получены с помощью xwd или GIMP и
конвертированы с помощью convert. Все данное программное обеспечение входит в поставку Mandrakelinux и является
свободным программным обеспечением.

http://www.gnu.org/licenses/fdl.html
http://linux-mandrake.com/en/doc/project/Borges/


Содержание
Предисловие . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

1. О Mandrake Linux . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
1.1. Контакт с сообществом Mandrake . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
1.2. Вступайте в Клуб . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
1.3. Приобретение продуктов Mandrake . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
1.4. Вклад в Mandrake Linux . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

2. Об этом руководстве по быстрому старту . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
1. Инсталляционное предупреждение . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
2. Перед началом инсталляции . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

2.1. Настройка BIOS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
2.2. Создание загрузочной дискеты . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

2.2.1. Создание загрузочной дискеты в Windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
2.2.2. Создание загрузочной дискеты в GNU/Linux . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

2.3. Поддерживаемое оборудование . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
2.3.1. Что не поддерживается . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

3. Инсталляция с DrakX . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
3.1. Инсталлятор Mandrake Linux . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
3.2. Выбор языка . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
3.3. Лицензия дистрибутива . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
3.4. Класс установки . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
3.5. Настройка мыши . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
3.6. Настройка клавиатуры . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
3.7. Уровень безопасности . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
3.8. Выбор точек монтирования . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
3.9. Выбор разделов для форматирования . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
3.10. Выбор пакетов для установки . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

3.10.1. Выбор группы пакетов для установки . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
3.10.2. Выбор отдельных пакетов для установки . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .19

3.11. Установка с нескольких компакт-дисков . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
3.12. Пароль Root . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
3.13. Добавление пользователя . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
3.14. Установка начального загрузчика . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
3.15. Проверка различных параметров . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

3.15.1. Сводка . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
3.15.2. Параметры часового пояса . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
3.15.3. Настройка графического сервера X. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
3.15.4. Настройка сети . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
3.15.5. Установка начального загрузчика . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
3.15.6. Настройка пунктов начального загрузчика . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .29
3.15.7. Выбор сервисов, которые загружаются при запуске системы . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

3.16. Установка обновлений из Интернет . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .30
3.17. Все завершилось! . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30
3.18. Как удалить Linux. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .31

4. Миграция из Windows®/Mac OS X® . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
4.1. Где мои...? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

4.1.1. Стартовое меню . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
4.1.2. Приложения . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
4.1.3. Панель управления/Настройки системы . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
4.1.4. DOS Shell . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
4.1.5. Сетевое окружение . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
4.1.6. Диск C: . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
4.1.7. Устройство CD-ROM . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
4.1.8. Дисковод . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
4.1.9. Мои документы . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34

4.2. Бравый новый мир! . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
4.2.1. Многопользовательская среда . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
4.2.2. Многозадачность . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

iii



4.2.3. Несколько рабочих столов . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
4.2.4. Полная настройка рабочего стола . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
4.2.5. Тысячи свободных приложений . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
4.2.6. Больше никаких перезагрузок! . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

5. Linux для начинающих . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
5.1. Введение . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
5.2. Меню начального загрузчика . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
5.3. Приготовьтесь к вашему первому сеансу . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .37
5.4. Начало вашего сеанса . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

5.4.1. Самоидентификация . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
5.4.2. Мастер первого запуска . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
5.4.3. Некоторые заметки относительно безопасности . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40

5.5. Использование графической среды . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
5.5.1. Рабочий стол Mandrake Linux . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
5.5.2. Доступ к программам . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
5.5.3. Открытие окна на рабочем столе . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
5.5.4. Управление окнами и рабочими столами . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
5.5.5. Персонализация рабочего стола . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45

5.6. Выход из сеанса . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
6. Где взять документацию . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

6.1. Документация, поставляемая с Mandrake Linux . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
6.1.1. Собственная документация Mandrakesoft . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
6.1.2. Страницы руководств (man pages) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
6.1.3. Страницы Info . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
6.1.4. HOWTOs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
6.1.5. Каталог /usr/share/doc . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49

6.2. Интернет . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
6.2.1. Web-сайты, посвященные GNU/Linux . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
6.2.2. Списки рассылок . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
6.2.3. Группы новостей . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50

6.3. Общие принципы решения проблем под Mandrake Linux . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
6.3.1. Поиск в Интернет . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
6.3.2. Архивы списков рассылок и групп новостей . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
6.3.3. Вопросы в списки рассылок и группы новостей . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
6.3.4. Прямой контакт с ответственным лицом . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
6.3.5. Бизнес услуги Mandrake. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .52

7. Internet . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
7.1. Browsing the Web . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

7.1.1. Konqueror’s Web Browser Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
7.1.2. Surfing the Web . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
7.1.3. Managing Bookmarks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54
7.1.4. Tabbed Browsing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
7.1.5. Konqueror Web Browser and Plugins . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56

iv



Список таблиц
7-1. Konqueror’s Web Browser Tool Bar Buttons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

Список иллюстраций
2-1. Программа Rawrite . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
3-1. Самый первый приветственный экран установки . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
3-2. Доступные параметры инсталляции . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
3-3. Выбор языка по умолчанию . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
5-1. Окно входа . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
5-2. Выпадающий список типов сеансов . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
5-3. Мастер первого запуска . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
5-4. Рабочий стол KDE . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
5-5. Меню приложений для KDE . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
5-6. Файловый менеджер KDE . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
5-7. Кнопки виртуальных рабочих столов KDE . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
5-8. Распахивание окон . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
5-9. Сворачивание окон . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .44
5-10. Панель задач в KDE . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
5-11. Закрытие окна . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
5-12. Подтверждение выхода из KDE . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
5-13. Выход с помощью всплывающего меню в KDE . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
7-1. Konqueror as a Web Browser . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
7-2. Konqueror’s Bookmarks Manager Dialog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54
7-3. Konqueror’s Browser Tabs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
7-4. Plugins Settings under Konqueror . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56

v



vi



Предисловие

1. О Mandrake Linux

Mandrakelinux –– это дистрибутив GNU/Linux, поддерживаемый компанией MandrakeSoft S.A., которая
родилась в Интернет в 1998 году. Главной ее целью было и остается продвижение простой в использовании
и дружественной GNU/Linux системы. Две опоры MandrakeSoft это открытые исходники и совместная
работа.

1.1. Контакт с сообществом Mandrake

Следующие различные интернет-ссылки приведут вас на разнообразные ресурсы, посвященные Man-
drakelinux. Если вы желаете узнать больше о компании MandrakeSoft, зайдите на ее web-сайт (http:
//www.mandrakesoft.com/). Кроме того, вы можете посетить сайт дистрибутива Mandrakelinux (http://
www.mandrakelinux.com/) и всего, что к нему относится.

MandrakeExpert (http://www.mandrakeexpert.com/) –– это созданная MandrakeSoft платформа предоставления
помощи. Этот сайт предлагает новый опыт, основанный на доверии и получении удовлетворения от
полезности другим людям в обмен на их пожертвования. Это не просто еще один сайт, где одни люди
помогают другим в решении их компьютерных проблем в обмен на оплату, соответствующую качеству
предоставленной помощи.

Мы также приглашаем вас принять участие в различных списках рассылок (http://www.mandrakelinux.
com/ru/flists.php3), где сообщество Mandrakelinux проявляет оживление и увлеченность.

И наконец, не забывайте заходить на MandrakeSecure (http://www.mandrakesecure.net/). Этот сайт
посвящен всем аспектам безопасности дистрибутивов Mandrakelinux. Именно здесь вы найдете консультации
по вопросам безопасности и багам, а также статьи на тему безопасности и секретности. Эта информация
является необходимой для каждого системного администратора или пользователя, заинтересованного в
защите.

1.2. Вступайте в Клуб
MandrakeSoft гордится тем, что предлагает своим пользователям широкий спектр преимуществ, которые
можно получить в Клубе Пользователей Mandrake (http://www.mandrakelinux.com/ru/club/) и Корпоративном
Клубе Mandrake (http://www.mandrakelinux.com/corporateclub). Это:

• возможность загружать коммерческое программное обеспечение, которое обычно доступно только в
коробочных версиях. Сюда входят драйвера, коммерческие приложения, свободно распространяемые
программы, а также демо-версии;

• право голосовать и предлагать новое программное обеспечение через систему голосования за RPM,
запущенную добровольцами;

• доступ к более чем 50,000 RPM пакетов для всех дистрибутивов Mandrakelinux;

• возможность получать скидки на продукты и услуги на MandrakeStore (http://www.mandrakestore.
com);

• доступ к лучшему списку зеркал, созданному специально для членов Клуба;

• возможность читать форумы и статьи на многих языках.

В MandrakeClub ваш голос будет услышан!

Финансируя MandrakeSoft через MandrakeClub, вы будете непосредственно развивать дистрибутив Man-
drakelinux и помогать нам создавать самый лучший из возможных десктопных GNU/Linux для наших
пользователей.
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Предисловие

1.3. Приобретение продуктов Mandrake

Пользователи Mandrakelinux могут легко воспользоваться нашим web-магазином MandrakeStore (http://
www.mandrakestore.com/) для приобретения продуктов в он-лайн. Здесь вы найдете не только программное
обеспечение Mandrakelinux, операционные системы и сетевые утилиты (Multi Network Firewall), но и
специальные подписные предложения, поддержку, программное обеспечение третьих фирм и лицензии,
книги по GNU/Linux, а также другие приятные вещицы и атрибутику от MandrakeSoft.

1.4. Вклад в Mandrake Linux

Навыки многих талантливых людей, которые используют Mandrakelinux, могут оказаться полезными в
создании системы Mandrakelinux:

• Сборка пакетов. Система GNU/Linux в основном собирается из программ, разбросанных по интернету.
Их нужно собирать в пакеты, чтобы они могли работать совместно.

• Программирование. Есть очень много проектов, которые поддерживаются непосредственно Mandra-
keSoft: найдите для себя проект по душе и предложите помощь основному разработчику (разработчикам).

• Интернационализация. Вы можете помочь нам в переводе web-страниц, программ и соответствующей
им документации.

• Документация. Последнее, но немаловажное: руководство, которое вы сейчас читаете, требует очень
много работы по поддержанию его на соответствующем уровне эволюции системы.

Обратитесь к странице спонсоров (http://www.mandrakesoft.com/labs/), чтобы узнать о том, как вы
можете помочь развитию Mandrakelinux.

2. Об этом руководстве по быстрому старту

Добро пожаловать и спасибо за выбор Mandrakelinux! Это Руководство к быстрому старту поможет вам
понять основы установки дистрибутива GNU/Linux, предоставит вам указания относительно того, что вам
нужно сделать перед началом установки OS Mandrakelinux, а также даст вводный курс по окружению
GNU/Linux

Гл. 1 расскажет вам о технических процедурах, которые необходимо сделать перед установкой (это не
обязательно, но, скажем так, мы настоятельно рекомендуем вам следовать инструкциям данной главы).
Мы поговорим о резервном копировании данных, scandisk, и подобном.

В Гл. 2 мы затрагиваем такие темы, как настройка BIOS, загрузочные диски и поддерживаемое
оборудование.

Далее следует глава, которую вы ждали: Гл. 3. В ней содержатся инструкции по процессу инсталляции
системы.

Удачи вам!
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Глава 1. Инсталляционное предупреждение

Данное руководство по установке описывает только самые общие этапы инсталляции. Если вы планируете
использовать как Windows, так и GNU/Linux в режиме двойной загрузки (dual-boot) (имеется в виду
возможность доступа к обеим операционным системам на одном компьютере), возьмите на заметку, что
будет проще установить Windows перед инсталляцией GNU/Linux. Если Windows уже установлена на ваш
компьютер, и вы еще никогда не инсталлировали GNU/Linux на этот компьютер, тогда инсталляционная
программа Mandrakelinux DrakX должна будет изменить размер раздела, на котором находится Windows.
Данная операция может повредить ваши данные. Следовательно, вы должны выполнить следующие
действия перед началом инсталляции:

• вы должны запустить scandisk на вашем компьютере под Windows. Программа изменения размера
может обнаружить несколько очевидных ошибок, но scandisk лучше предназначен для этой задачи.

Перед тем, как использовать scandisk(или defrag),
проверьте, выключен ли хранитель экрана или любая
другая программа, которая может делать запись на
жесткий диск. Более того, даже лучше будет запустить
scandisk в Windows“Safe Mode”.

• для максимальной безопасности ваших данных вы также должны запустить на своем разделе
программу defrag. Это также уменьшит риск потери данных. Делать это не обязательно, но очень
рекомендуется, потому что процесс изменения размера раздела диска пройдет проще и быстрее.

• стопроцентная гарантия отсутствия проблем –– это создание резервной копии ваших данных (back
up)! Естественно, что сохранить данные нужно на другом компьютере, или загрузить данные куда-
нибудь в web, или на компьютер друга, и т.д. Не создавайте резервную копию данных на том же самом
компьютере, куда вы собираетесь инсталлировать GNU/Linux.

Если scandisk или defrag не инсталлированы на Windows, пожалуйста, обратитесь к документации Windows
за инструкциями по их инсталляции.

NTFS разделы. Пользователи Windows 2000, NT или
XP должны быть очень осторожны: в GNU/Linux можно
производить изменения размера разделов NTFS, однако
настойчиво рекомендуется сохранить ваши данные перед
началом инсталляции. За изменение разделов на диске вы
отвечаете самостоятельно.
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Глава 2. Перед началом инсталляции

В этой главе рассказывается о том, что нужно сделать перед тем, как вы начнете установку вашей
системы Mandrakelinux. Внимательно прочитайте раздел, чтобы избежать возможных трудностей. Кроме
того, создайте резервную копию ваших данных (на другом диске, на который не будет производиться
установка), а также подсоедините к компьютеру и включите все ваши внешние устройства (клавиатуру,
принтер, сканер, мышь и т.д.).

2.1. Настройка BIOS

BIOS (Basic Input/Output System (базовая система ввода/вывода)) используется для загрузки вашего
компьютера. Именно она определяет, где находится операционная система, и загружает ее. Кроме того,
она нужна для первоначальной настройки оборудования и доступа к оборудованию на низком уровне.

Появление и широкое использование plug’n’play ведет к тому, что все современные BIOS могут инициализировать
это устройство. Чтобы Linux мог распознать устройства plug’n’play, ваш BIOS должен быть настроен для их
инициализации.

Изменение настроек BIOS обычно выполняется по нажатию Del (в некоторых BIOSах вместо Del
используются клавиши F2, F10 или Esc) сразу по включении питания компьютера. К сожалению,
существует много вариантов BIOS; следовательно, вы должны найти подходящую опцию в своем BIOS
самостоятельно. Название искомой опции PNP OS installed (или Plug’n’Play OS installed). Установите
значение этой опции в No, и тогда BIOS будет самостоятельно инициализировать любые plug’n’play
устройства. Это может помочь GNU/Linux распознать некоторые устройства на вашей машине, которые
в ином случае инициализировать невозможно.

Все не так давно выпущенные системы умеют загружаться с CD-ROM. Поищите Boot sequence (последовательность
загрузки) в настройках BIOS-а и установите загрузку с CD-ROM. Если вы не можете загрузиться с CD-
ROM, вам придется использовать дискету.

Если вы хотите использовать параллельный принтер,
подключенный к вашей локальной машине, проверьте,
чтобы режим последовательного порта был установлен в
значение ECP+EPP (или хотя бы один из вариантов ECP
или EPP), но не в SPP, если у вас действительно не такой
старый принтер. Если параллельный порт не будет настроен
таким образом, то вы, возможно, сможете печатать, но
автоматически принтер определен не будет, и вам придется
настраивать его вручную. Также проверьте, чтобы питание
принтера было включено и принтер заранее был подключен
к компьютеру.

2.2. Создание загрузочной дискеты
Если у вас не получается загрузиться с CD-ROM, тогда вам необходимо создать загрузочную дискету.
CD-ROM содержит все файлы образов дисков (image) и необходимые для этого утилиты.

Образы загрузочных дискет находятся на CD-ROM в каталоге images/.

Далее следует список различных образов и соответствующие им методы инсталляции:

cdrom.img

Для установки с локального устройства IDE или SCSI CD-ROM. Этот образ нужно использовать в
случае, когда вы не можете загрузить компьютер непосредственно с CD-ROM.

network.img

Для установки с репозитория NFS, FTP, HTTP, вашей локальной сети (LAN) или через сетевое
соединение PPPoE (DSL линии). Настройки сети машины, на которую производится установка, могут
быть сделаны вручную или автоматически.
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pcmcia.img

Используйте этот образ, если носитель с инсталляцией доступен через карту PCMCIA (сеть, CD-ROM,
и т.д.).

Некоторые устройства PCMCIA сейчас используют обычные
сетевые драйвера. Если устройство PCMCIA не работает,
попробуйте network.img.

hd.img

Используйте этот образ, если желаете провести установку с жесткого диска. Вам нужно будет
предварительно скопировать содержимое CD на жесткий диск (на любой из FAT ext2FS, ext3FS или
ReiserFS разделов).

hdcdrom_usb.img

Этот образ позволяет произвести установку с запоминающих устройств USB, таких, как внешний CD-
ROM или жесткий диск.

network_gigabit_usb.img

Этот установочный образ позволяет произвести установку с репозитория NFS, FTP, HTTP, используя
сетевой адаптер Gigabit (GbE) или USB.

images/alternatives/*: этот каталог содержит более или менее одинаковые образы загрузки, но с
разными (ранними) ядрами. На самом деле в них поставляется ядро 2.2 (Mandrakelinux 9.0 использует ядро
2.4), что, возможно, поможет вам запуститься на более старых системах.

2.2.1. Создание загрузочной дискеты в Windows

Вам нужно использовать программу rawwrite. Ее можно найти на CD-ROM в каталоге dosutils.

Возможно, вы знаете, что существует версия DOS этой же программы под названием rawrite. Это,
фактически, оригинальная версия программы. rawwrite является графическим интерфейсом к ней.

Запустите программу, как показано здесь Рис. 2-1.

Рисунок 2-1. Программа Rawrite

Выберите загрузочный образ для копирования и целевое устройство. Практически во всех случаях целевое
устройство –– это диск A: (первый дисковод).
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Затем вставьте чистый диск в выбранный дисковод, если вы еще этого не сделали, и нажмите кнопку Write.
Когда закончите, нажмите Exit: теперь у вас есть загрузочный диск для установки вашего дистрибутива
Mandrakelinux.

2.2.2. Создание загрузочной дискеты в GNU/Linux

Если у вас уже установлена GNU/Linux (другая версия или на другой машине), тогда сделайте следующее:

1. примонтируйте CD-ROM. Предположим, что точка монтирования –– это /mnt/cdrom;

2. войдите в систему как root (чтобы это сделать, откройте окно терминала, наберите команду su и
введите пароль root);

3. вставьте чистый диск в дисковод и наберите:
$ dd if=/mnt/cdrom/images/cdrom.img of=/dev/fd0 bs=512

Замените /dev/fd0 на /dev/fd1 если вы используете
второй дисковод, и, конечно, название нужного вам образа
диска. Когда операция закончится, вы получите готовую к
использованию загрузочную дискету.

2.3. Поддерживаемое оборудование
Mandrakelinux может работать с большим количеством аппаратных устройств; их список слишком
длинный, чтобы отобразить его здесь. Однако некоторые действия, описанные в этой главе, помогут вам
определить совместимость вашего оборудования и настроить некоторые проблематичные устройства.

Вы можете ознакомиться со списком поддерживаемого в настоящий момент оборудования на нашем web-
сайте (http://www.mandrakelinux.com/ru/hardware.php3).

USB устройства: их поддержка USB 1.0 и USB 2.0 в настоящий момент является полной. Большинство
периферии поддерживается полностью. Список поддерживаемого оборудования можно получить на сайте
Linux-USB Device (http://www.qbik.ch/usb/devices/).

Официальный отказ: Список поддерживаемого
оборудования Mandrakelinux содержит информацию об
аппаратных средствах, которые были тестированы и/или
о них сообщено, что они должным образом работают с
Mandrakelinux. По причине большого количества возможных
вариантов системных конфигураций, MandrakeSoft не
может гарантировать того, что специфическое устройство
будет работать правильно на вашей системе.

2.3.1. Что не поддерживается
Некоторые типы оборудования в настоящий момент не могут поддерживаться GNU/Linux –– либо по
причине того, что поддержка находится в экспериментальной стадии, потому что никто пока не написал
для них драйвер, либо по некоторым причинам было решено не поддерживать данные устройства.
Например:

• winmodems, также называемые модемы-без-контроллера или софтовые модемы. Поддержка таких
устройств очень редка. Драйвера существуют, но только в скомпилированном виде и для ограниченного
числа версий ядра.
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Если у вас PCI модем, посмотрите на результат команды cat /proc/pci, выполненной под root. Она
сообщит вам I/O port и IRQ устройства. Затем используйте команду setserial (для нашего примера
I/O адрес это 0xb400 и IRQ - 10) так:

setserial /dev/ttyS3 port 0xb400 irq 10 UART 16550A

Теперь посмотрите, можете ли вы сделать запрос к вашему модему, используя minicom или kppp. Если
это не работает, то у вас, скорее всего, софтовый модем. Если работает, создайте файл /etc/rc.d/rc.
setserial и разместите в нем строку соответствующей команды setserial.

Недавно основан проект, который пытается заставить софтовые модемы работать под GNU/Linux. Если
случилось так, что в вашей машине имеется этот тип оборудования, вы можете взглянуть на сайты
linmodems dot org (http://linmodems.org/) и Winmodems are not modems; Linux information page
(http://www.idir.net/~gromitkc/winmodem.html).

8

http://linmodems.org/
http://www.idir.net/~gromitkc/winmodem.html


Глава 3. Инсталляция с DrakX

3.1. Инсталлятор Mandrake Linux

DrakX это программа установки Mandrakelinux. Не зависимо от того, впервые ли вы встретились с Mandra-
kelinux или гуру –– в задачи DrakX входит сделать установку понятной и простым переход к новой версии
Mandrakelinux.

DrakX будет лучше работать, если вы перед установкой
подключите к компьютеру и включите питание всем
устройствам, которые должны работать потом в системе.
Принтеры, сканеры, модемы и джойстики это лишь
некоторые примеры периферии, которую DrakX может
автоматически определить и настроить в процессе установки
Mandrakelinux.

Рисунок 3-1. Самый первый приветственный экран установки

Когда вы начнете установку, появится первый экран с некоторой информацией и возможностью выбрать
параметры установки. (Рис. 3-1). Если ничего не делать, инсталляция просто начнется в нормальном
режиме или режиме “linux”. В следующих нескольких параграфах будут рассмотрены некоторые
параметры и опции, которые вы можете передать программе установки, если у вас возникли проблемы.

По нажатию F1 откроется экран помощи (Рис. 3-2). В нем есть такие опции для выбора:
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Рисунок 3-2. Доступные параметры инсталляции

• vgalo: если вы запустили установку по умолчанию, но не увидели графического интерфейса как
показано здесь Рис. 3-3, вы можете попробовать запустить инсталляцию в режиме пониженного
разрешения. Такое случается с некоторыми типами графических карт, поэтому в Mandrakelinux мы
предоставляем несколько опций для решения проблем со старым оборудованием. Чтобы начать
инсталляцию в более низком разрешении, напишите vgalo в приглашении.

• text: если ваша видеокарта очень древняя и графическая инсталляция не работает вовсе, вы всегда
можете выбрать установку в текстовом режиме. Все видеокарты умеют отображать текст, поэтому этот
вариант можно рассматривать как “ вариант установки на крайний случай”. Не беспокойтесь об этом,
скорее всего вам не прийдется к этому прибегать.

• noauto: в крайне редких случаях ваш компьютер может замереть или зависнуть во время определения
оборудования. Если это случилось, тогда слово noauto в качестве параметра сообщит инсталлятору
о том, что нужно пропустить определение оборудования. В этом случае DrakX не будет сканировать
оборудование, поэтому вам прийдется вручную указывать параметры оборудования позже в процессе
инсталляции. Параметр noauto можно добавлять к предыдущим режимам, то есть вы можете написать
так:
boot: vgalo noauto

чтобы DrakX взял более низкое разрешение графики для инсталляции и пропустил сканирование
оборудования.

• kernel options: Параметры ядра обычно не требуются для большинства машин. Бывают редкие
случаи, когда материнские платы некорректно сообщают о количестве установленной памяти из-за
ошибок в дизайне или в BIOS. Если вам потребуется вручную ввести количество DRAM памяти,
установленной на вашей машине, используйте параметр mem= xxxM. Например, чтобы запустить
установку в нормальном режиме на компьютере с объемом памяти 256 MB, ваша командная строка будет
выглядеть примерно так:
boot: linux mem=256M

Теперь, когда мы рассмотрели случаи, когда что-то могло работать неверно, давайте перейдем к
самому процессу установки. Когда инсталлятор запустится, вы увидите симпатичный графический
интерфейс (Рис. 3-3). Слева будут отображаться различные шаги инсталляции. Вы можете заметить, что
установка будет происходить в два различных основных этапа: установка и затем настройка. Список слева
показывает все шаги. Текущий шаг выделен подсветкой.

Каждый шаг может предлагать различные экраны. Навигация между ними осуществляется кнопками
Далее -> и <- Назад. Иногда может появляться кнопка Дополнительно, которая предлагает настроить
дополнительные параметры.

Кнопка Справка показывает пояснения к текущему шагу.
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3.2. Выбор языка

Первый шаг это выбор предпочитаемого языка.

Рисунок 3-3. Выбор языка по умолчанию

Ваш выбор предпочитаемого языка повлияет на язык документации, сам инсталлятор и систему в целом.
Выберите сначала регион, в котором вы находитесь, затем язык на котором вы говорите.

По нажатию на кнопку Дополнительно вы сможете выбрать другие языки, которые можно установить на
вашей рабочей станции. Таким образом будут установлены имеющие отношение к языку файлы системной
документации и приложения. Например, если у вас в системе будут работать пользователи из Испании,
выберите в дереве English как основной, и Espanol в дополнительном разделе.

О поддержке UTF-8 (unicode): Unicode это новая кодировка,
которая включает в себя все существующие языки. Однако
ее полная поддержка в GNU/Linux пока находится в
стадии разработки. Поэтому Mandrakelinux будет определять
использовать ее или нет в зависимости от выбора
пользователя:

1. Если вы выбираете языки, которые имеют свою
традиционную устоявшуюся кодировку (языки la-
tin1, русский, японский, китайский, корейский,
тайский, греческий, турецкий, большинство языков
с iso-8859-2), будет взята по умолчанию их
кодировка;

2. Для остальных языков будет использоваться
юникод по умолчанию;

3. Если выбираются несколько языков, имеющих
различную кодировку, будет использован юникод
по умолчанию для всей системы;

4. И наконец, юникод может быть также выбран
по запросу пользователя, опцией Использовать по
умолчанию Unicode не зависимо от того, какие
языки выбраны.
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Заметим, что вы не ограничены в выборе дополнительных языков. Вы можете выбрать сколько угодно
дополнительных языков, даже установить все языки, отметив пункт Все языки. Выбор поддержки языка
означает наличие переводов, шрифтов, проверку орфографии и т.д. для установленных языков.

Для переключения между различными установленными
языками в вашей системе вы можете запускать команду
/usr/sbin/localedrake с правами root, чтобы изменить
язык для всей системы. Запуск этой команды с правами
обычного пользователя позволит изменить настройки языка
для данного конкретного пользователя.

3.3. Лицензия дистрибутива

Прежде чем продолжить, вам следует внимательно прочитать условия лицензии. Она касается всего
дистрибутива Mandrakelinux. Если вы согласны со всеми ее условиями, выберите Принять. Если нет,
нажмите кнопку Выйти и ваш компьютер будет перезагружен.

3.4. Класс установки
Этот шаг появляется только в случае, если на вашей машине найден старый раздел GNU/Linux.
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DrakX теперь должен узнать, хотите ли вы провести новую установку или обновление существующей
системы Mandrakelinux:

• Установка: в большинстве случаев этот вариант приведет к уничтожению старой системы. Если вы
желаете изменить разделы вашего жесткого диска или изменить файловую систему, вы должны выбрать
этот пункт. Однако, в зависимости от того, как разбит ваш диск, вам, возможно, удастся сохранить от
перезаписи некоторые свои данные.

• Обновление: этот класс установки позволит вам обновить пакеты, установленные в вашей системе
Mandrakelinux. Текущая схема разделов диска и пользовательские данные останутся нетронутыми.
Большинство других шагов будут доступны, как и при стандартной установке.

“Обновление” будет неплохо работать на системах Mandra-
kelinux начиная с 8.1 и выше. Проведение обновления на
системах Mandrakelinux старше 8.1 не рекомендуется.

3.5. Настройка мыши
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Обычно у DrakX не возникает проблем с определением количества кнопок вашей мыши. Если все-таки
у него это не получается, тогда он будет рассматривать вашу мышь как двух-кнопочную и настроит
эмуляцию трех кнопок. Третья кнопка двухкнопочной мыши может быть “нажата” одновременным
нажатием на левую и правую кнопку. DrakX автоматически определит какой интерфейс использует ваша
мышь: PS/2, serial или USB.

Если, по каким-либо причинам, вы желаете указать другой тип мыши, выберите нужную мышь из
предоставленного списка.

Если вы выбираете другую мышь, отличную от выбранной по умолчанию, появится тестовый экран.
Понажимайте кнопки и покрутите колесико для проверки правильности настроек и того, что мышь
работает корректно. Если мышь ведет себя неверно, нажмите пробел или клавишу Return, чтобы отменить
тестирование и вернуться к списку мышей.

Мыши с колесиками иногда автоматически не определяются.
В этом случае вам прийдется выбрать свою мышь из списка.
Проверьте, что вы правильно выбрали порт подключения
мыши. Когда мышь будет выбрана и нажата кнопка Далее -
>, появится картинка с изображением мыши. Покрутите
колесико мыши для проверки того, что все работает
правильно. Как только вы увидите, что колесико на экране
движется синхронно с движениями настоящего колесика,
проверьте также работу кнопок и движение курсора,
который должен двигаться по экрану соответственно вашим
перемещениям мыши.

3.6. Настройка клавиатуры

В зависимости от языка по умолчанию, который вы выбрали в разделе Разд. 3.2, DrakX автоматически
подберет определенную конфигурацию клавиатуры. Проверьте, что выбор вам подходит или выберите
другую раскладку клавиатуры.

Может так быть, что у вас нет клавиатуры, которая точно соответствует вашему языку: например, если
вы швейцарец, говорящий по-английски, у вас может быть швейцарская клавиатура. Или вы говорите
по-английски, но живете в Квебеке; тогда вы можете попасть в подобную в ситуацию, когда ваш родной
язык и клавиатура не совпадают. В любом случае, этот шаг установки позволит вам выбрать подходящую
клавиатуру из списка.

Нажмите на кнопку Больше чтобы получить полный список поддерживаемых клавиатур.
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Если вы выбираете раскладку клавиатуры, основанную на не-латинском алфавите, следующее диалоговое
окно позволит вам выбрать сочетание клавиш для переключения между латинской и не-латинской
раскладками.

3.7. Уровень безопасности

На этом этапе DrakX позволит вам выбрать для машины желаемый уровень безопасности. Как правило,
уровень безопасности должен быть выше, если на машине содержатся критические данные или машина
непосредственно подключена к Интернет. Однако, более высокий уровень безопасности, в общем случае,
достигается в обмен на удобство использования.

Если вы не знаете что выбрать, оставьте выбор по умолчанию. Вы сможете изменить этот уровень
безопасности потом с помощью утилиты draksec из Mandrakelinux Control Center.

В поле Администратор по безопасности системе указывается пользователь, который будет отвечать за
безопасность. На этот адрес будут посылаться сообщения по безопасности.

3.8. Выбор точек монтирования
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На этом шаге вам прийдется решить, куда вы хотите установить операционную систему Mandrakelinux
на вашем жестком диске. Если ваш жесткий диск пуст, или существующая операционная система на
нем занимает все дисковое пространство, вам прийдется диск переразбить (partition). Разделение диска
в основном состоит в том, чтобы логически выделить на нем свободное пространство для установки вашей
новой системы Mandrakelinux.

Поскольку разделение диска – это обычно необратимый процесс и может привести к потере данных, если
на диске уже есть установленная операционная система, то для начинающего пользователя это несколько
напряженный и пугающий момент. К счастью, в DrakX существует мастер, упрощающий этот процесс.
Пожалуйста, прочтите руководство перед началом и не торопитесь.

В зависимости от конфигурации вашего жесткого диска, доступно несколько параметров:

• Использовать свободное место: эта опция означает автоматическое разделение пустого диска или
дисков. Если вы выбираете эту опцию, то далее вопросов задаваться не будет;

• Использовать существующие разделы: мастер определил наличие существующих разделов Linux на
вашем жестком диске. Если вы собираетесь их использовать, выберите эту опцию. Вас попросят
указать точки монтирования для каждого раздела. По умолчанию выбираются традиционные точки
монтирования и вы можете вообще их не менять.

• Использовать свободное место на разделе Windows: если на вашем жестком диске установлена и
занимает все доступное место Microsoft Windows, вам нужно будет создать свободное место для данных
Linux. Чтобы это сделать, вы можете удалить ваш Microsoft Windows раздел и данные (см. решение
“ Очистить весь диск”) или изменить размер раздела FAT или NTFS Microsoft Windows. Изменение
размера может проводиться без потери данных, особенно если вы предварительно провели
дефрагментациюраздела Windows. Резервное копирование вашихданныхнастойчиво рекомендуется..
Рекомендуем выбрать эту опцию, если вы собираетесь использовать Mandrakelinux и Microsoft Windows
на одном компьютере.

Перед тем, как выбрать эту опцию, вы должны осознать, что размер вашего раздела Microsoft Windows
станет меньше, чем был. У вас будет меньше свободного места под Microsoft Windows для хранения
данных и инсталляции новых программ.

• Очистить весь диск выберите эту опцию, если вы хотите удалить все данные на всех разделах вашего
жесткого диска и заменить их новой системой Mandrakelinux. Будьте осторожны в этом решении, потому
что после подтверждения вы не сможете вернуть обратно все как было.

Если вы выбираете эту опцию, все данные на вашем
жестком диске будут удалены.

• Удалить Windows: эта опция позволит просто удалить всю информацию на диске и начать создание
разделов диска на пустом месте. Вся информация на вашем диске будет утеряна.

Если вы выберете эту опцию, все данные на вашем диске
будут потеряны.

• Ручная разметка диска: выберите эту опцию, если вы желаете разбить ваш диск вручную. Будьте
осторожны –– это мощная и одновременно опасная возможность. Вы запросто можете потерять все
данные. Поэтому выбор этой опции рекомендуется только в том случае, если вы уже делали что
либо подобное раньше и имеете некоторый опыт. Чтобы узнать, как использовать утилиту DiskDrake,
обратитесь к разделу Управление разделами диска книги Стартовое руководство пользователя .
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3.9. Выбор разделов для форматирования

Все вновь созданные разделы должны быть отформатированы для того, чтобы их можно было использовать
(форматирование означает создание файловой системы).

На этом этапе у вас есть возможность переформатировать уже существующие разделы, чтобы стереть все
данные, которые они содержат. Если вам это нужно, тогда выберите и эти разделы.

Пожалуйста, имейте в виду, что нет необходимости переформатировать все существовавшие ранее
разделы. Вы должны переформатировать разделы, содержащие операционную систему (такие, как /, /usr
или /var), но вам совсем не обязательно форматировать разделы, на которых содержатся данные, которые
вы хотели бы сохранить (обычно это /home).

Пожалуйста, будьте осторожны при выборе разделов. После форматирования все данные на выбранных
разделах будут удалены и вы не сможете их восстановить.

Нажмите Далее ->, когда будете готовы начать форматирование разделов.

Нажмите <- Назад, если вы хотите выбрать другой раздел для установки Mandrakelinux.

Нажмите Дополнительно, если хотите выбрать разделы, которые следует проверить на сбойные блоки
(bad blocks).
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3.10. Выбор пакетов для установки

3.10.1. Выбор группы пакетов для установки

Теперь настало время определить, какие программы вы хотите установить в вашу систему. С Mandrakelinux
поставляются тысячи пакетов и, для упрощения выбора, они разбиты на группы.

Пакеты сортированы по группам, которые соответствуют специфике использования вашей машины. В
Mandrakelinux пакеты сортируются по четырем категориям. Вы можете смешивать и сочетать приложения
из различных категорий, например, вариант установки “Рабочая станция” может иметь приложения из
категории “Разработка”.

1. Рабочая станция: если вы собираетесь использовать машину в качестве рабочей станции, выберите
одну или несколько соответствующих групп из категории рабочей станции.

2. Разработка: если вы собираетесь заняться программированием, выберите соответствующие группы из
этой категории.

3. Сервер: если ваша машина будет работать сервером, выберите какие из часто используемых сервисов
вы желаете установить на нее.

4. Графическая среда: здесь вам нужно выбрать предпочитаемую графическую среду. Хотя бы одна из
них должна быть выбрана, если вы хотите работать в графическом интерфейсе.
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При наведении курсора мыши на имя группы будет
показываться короткое пояснение к данной группе.
Если вы не выберете ни одной группы в процессе
выполнения обычной инсталляции (не касается обновления),
появится диалог с различными опциями для минимальной
инсталляции:

• Вместе с Х: инсталлировать минимальный набор
пакетов, необходимых для работы графического
рабочего стола.

• С основной документацией: установить основную
систему плюс базовые утилиты и документацию
к ним. Эта инсталляция подходит для установки
сервера.

• Действительно минимальная установка: будет
установлен самый необходимый минимум пакетов
для работы Linux системы. В это варианте вы
сможете работать только в режиме командной
строки. Общий размер этой установки занимает 65
мегабайт.

ы можете отметить пункт Выбор отдельных пакетов, который очень полезен, если вы хорошо знаете
предлагаемые пакеты, или если вы хотите иметь полный контроль над тем, что будет устанавливаться.

Если вы начали инсталляцию в режиме Обновление, вы можете убрать выбор всех групп, чтобы
предотвратить инсталляцию какого-либо нового пакета. Это полезно в случае восстановления или
обновления существующей системы.

3.10.2. Выбор отдельных пакетов для установки

Если вы сообщили инсталлятору, что вы хотите самостоятельно выбрать пакеты, тогда он покажет вам
дерево, содержащее все пакеты, разделенные по группам и подгруппам. Во время просмотра дерева вы
можете выбирать группы полностью, подгруппы или отдельные пакеты.

Когда вы выбираете пакет в дереве, справа появляется его описание, чтобы помочь вам узнать назначение
этого пакета.
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Если был выбран какой-либо серверный пакет, специально
или он был частью какой-либо группы, вас попросят
подтвердить, действительно ли вы желаете установить
эти сервера. Под Mandrakelinux все установленные сервера
запускаются по умолчанию в процессе загрузки. Даже если
они безопасны и не имеют известных проблем на момент
выпуска дистрибутива, в них могут быть обнаружены дыры
в безопасности после выпуска данной версии Mandrakeli-
nux. Если вы не знаете, зачем нужен данный сервис и
что он делает, нажмите Нет. Если вы нажмете Да, тогда
все сервисы из списка будут установлены и автоматически
запущены при загрузке системы.

Опция Автоматические зависимости запрещает показ
диалога предупреждения, который появляется при
автоматическом выборе пакетов инсталлятором. Некоторые
пакеты имеют взаимосвязь друг с другом, поэтому
инсталлятору может потребоваться установить некоторые
дополнительные программы. Инсталлятор сам определит,
какие пакеты нужны для удовлетворения зависимостей,
чтобы успешно выполнить установку.

Маленькая иконка дискеты внизу под списком позволяет
загрузить выбранный и записанный во время предыдущей
инсталляции список пакетов. Если вы нажмете на эту
иконку, вас попросят вставить в дисковод дискету,
созданную предыдущей инсталляцией. Смотрите второй
совет последнего шага, где описано как создать такой диск.

3.11. Установка с нескольких компакт-дисков

Инсталляция Mandrakelinux размещена на нескольких CD-ROMах. Если выбранный пакет находится на
другом CD-ROM, DrakX будет отдавать текущий CD и просить вас вставить другой по мере надобности.
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3.12. Пароль Root

Это самое важное решение в деле безопасности вашей системы GNU/Linux: вы должны ввести пароль root.
Root является администратором системы, и только он имеет право производить обновления, добавлять
пользователей, изменять конфигурацию системы и так далее. Короче говоря, root может все! Вот поэтому
вы должны придумать пароль, который трудно подобрать – DrakX сообщит вам, если пароль слишком
прост. Как вы видите, можно вообще не вводить пароль, но мы серьезно советуем вам этого не делать по
одной простой причине: не думайте, что если вы загрузили GNU/Linux, то ваши остальные операционные
системы защищены от ошибок. Так как root может переступить все ограничения и непреднамеренно
стереть все данные на разделах диска, обращаясь небрежно с разделами, то очень важно, чтобы стать
root было трудно.

Пароль должен быть сочетанием цифровых и буквенных символов и иметь длину не менее 8 символов.
Никогда не записывайте пароль root – это делает очень легкой возможность скомпрометировать систему.

Одно предостережение –– не делайте пароль слишком длинным или слишком сложным, потому что вы
должны его без особых усилий запомнить!

Пароль не будет отображаться на экране так же, как вы его вводите. Кроме того, вам прийдется повторить
ввод пароля, чтобы предупредить возможность опечатки. Если случится так, что вы опечатались дважды,
тогда этот “неверный” пароль прийдется использовать при первой загрузке.

Если вы желаете, чтобы доступ к этому компьютеру контролировался сервером аутентификации, нажмите
на кнопку Дополнительно.

Если ваша сеть использует сервисы аутентификации LDAP, NIS или PDC Windows Domain выберите
соответствующий тип аутентификации. Если не знаете что выбрать, спросите своего администратора сети.

Если у вас возникли проблемы с запоминанием паролей, вы
можете выбрать опцию Без пароля, если ваш компьютер не
будет подключаться к Интернет и если вы доверяете всем
доступ к своей машине.
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3.13. Добавление пользователя

GNU/Linux это многопользовательская система, что означает, что каждый пользователь может иметь
свои собственные настройки, свои файлы и так далее. Вы можете прочитать Стартовое руководство
пользователя чтобы узнать больше про многопользовательские системы. Кроме пользователя root,
который является системным администратором, пользователи, которых вы добавляете здесь не будут
иметь полномочий изменять что либо, кроме своих собственных файлов и своих настроек, что защищает
систему от неумышленных или злонамеренных изменений, которые влияют на всю систему в целом. Вам
нужно создать хотя бы одного обычного пользователя для себя –– этот аккаунт вы должны использовать
для повседневной работы. Несмотря на то, что это весьма просто входить в систему как root и делать все
что угодно, это еще и очень опасно! Самая простая ошибка может привести к тому, что система перестанет
работать вообще. Если же вы сделаете серьезную ошибку как обычный пользователь, то самое худшее, что
может случиться, это потеря некоторой личной информации, однако на всю систему это никак не повлияет.

Первое поле предлагает вам ввести ваше реальное имя. Конечно же, это не обязательно ––, и вы можете
написать все что угодно. DrakX скопирует первое слово из того, что вы ввели, в следующее поле Имя
пользователя, имя, которое вы будете вводить при входе в систему. Вы можете изменить это поле, если
пожелаете. Следующий шаг это ввод пароля. С точки зрения безопасности, пароль обычного пользователя
не так важен, как пароль root, но это не повод, чтобы делать его слишком простым: в конечном итоге вы
рискуете своими собственными файлами.

После того, как вы нажмете на кнопку Принять, вы сможете добавить других пользователей. Добавьте
пользователей для своих друзей, отца или своей сестры, например. Когда закончите, нажмите Далее ->.

Если нажать на кнопку Дополнительно, появится
возможность изменить shell для данного пользователя. (по
умолчанию используется bash).
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Когда вы закончите добавление пользователей, вам будет предложено выбрать пользователя, который
будет автоматически входить в систему при загрузке компьютера. Если вам интересна данная возможность
(и вас не сильно заботит локальная безопасность), выберите пользователя и оконный менеждер для него и
нажмите Далее ->. Если вам не нужен автоматический вход, снимите выбор с опции Хотите использовать
эту возможность?.

3.14. Установка начального загрузчика

LILO и GRUB –– это начальные загрузчики GNU/Linux. Этот шаг обычно полностью автоматизирован.
DrakX проанализирует загрузочный (boot) сектор диска и будет действовать согласно тому, что он там
найдет:

• если найден загрузочный сектор Windows, он заменит его на загрузочный сектор GRUB/LILO. Следовательно,
вы сможете загружать и GNU/Linux и другую OS, установленную на вашей машине.

• если найден загрузочный сектор GRUB или LILO, он заменит его на новый.

Если возникают сомнения, DrakX спросит вас куда разместить загрузчик. В общем случае, Первый сектор
диска (MBR) это лучший вариант выбора. Если выбрать Пропустить, тогда начальный загрузчик не будет
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установлен вообще. Используйте этот вариант только если вы знаете, что вы делаете.

3.15. Проверка различных параметров

3.15.1. Сводка

В качестве обзора DrakX представит сводку имеющейся у него различной информации о вашей системе. В
зависимости от установленного у вас оборудования, вы можете увидеть все или некоторые из следующих
пунктов. Каждый пункт состоит из конфигурационных элементов для настройки, сопровождаемых
небольшой сводкой о текущей конфигурации. Нажмите на соответствующую кнопку Настройка, чтобы
изменить настройки.

• Клавиатура: проверьте текущую настройку раскладки клавиатуры и сделайте поправку если необходимо.

• Страна / Регион: проверьте текущий выбор страны Если вы находитесь не в этой стране, нажмите на
кнопку Настройка и выберите другую. Если ваша страна не присутствует в первом показанном списке,
нажмите кнопку Больше, чтобы увидеть полный список.

• Часовой пояс: По умолчанию, DrakX выбирает часовой пояс, основываясь на выбранной вами стране.
Вы можете здесь нажать на кнопку Настройка, если выбранное неверно.

• Мышь: проверьте текущую конфигурацию мыши и нажмите на кнопку, если необходимо что-либо
изменить.

• Принтер: по нажатию на кнопку Настройка откроется мастер настройки принтера. Прочитайте
соответствующую главу в книге Стартовое руководство пользователя , чтобы узнать как установить
новый принтер. Представленный там интерфейс подобен используемому в процессе установки.

• Звуковая карта: если в вашей системе найдена звуковая карта, здесь это будет показано. Если вы
увидите, что показанная звуковая карта не соответствует тому, что у вас реально есть в системе, вы
можете нажать на кнопку и выбрать другой драйвер.

• Графический интерфейс: по умолчанию DrakX настраивает ваш графический интерфейс на разрешение
800x600 или 1024x768. Если вас это не устраивает, нажмите Настройка для внесения изменений в
конфигурацию вашего графического интерфейса.

• TV карта: если в вашей системе была обнаружена TV карта, она будет здесь показана. Если у вас есть TV
карта, но она не была определена, нажмите на кнопку Настройка и попробуйте настроить ее вручную.

• ISDN-карта: если в вашей системе обнаружена ISDN-карта, она будет здесь показана. Вы можете нажать
на кнопку Настройка для изменения связанных с ней параметров.

• Сеть: если вы хотите настроить доступ в Интернет или локальную сеть прямо сейчас.

• Уровень безопасности: этот пункт предлагает вам переопределить уровень безопасности .

24



Глава 3. Инсталляция с DrakX

• Файервол: если вы собираетесь подключать вашу машину к Интернет, неплохой идеей будет защитить
себя от вторжений извне, установив файервол. Прочитайте соответствующий раздел книги Стартовое
руководство пользователя , где описаны детали настройки файервола.

• Начальный загрузчик: если вы желаете изменить конфигурацию начального загрузчика, нажмите эту
кнопку. Эта опция предназначена для опытных пользователей.

• Сервисы: здесь вы сможете проконтролировать какие сервисы будут запущены на вашей машине. Если
ваша машина будет сервером, вам стоит проверить эти установки.

3.15.2. Параметры часового пояса

GNU/Linux управляет временем в GMT (Greenwich Mean Time) и транслирует его в локальное согласно
выбранного вами часового пояса. Если часы на вашей материнской плате установлены в локальное
время, вы можете деактивировать это, убрав выбор Аппаратные часы выставлены по GMT, что позволит
GNU/Linux помнить, что системные часы и аппаратные часы принадлежат разным часовым поясам. Это
полезно в случае, когда на машине размещена другая операционная система типа Windows.

Опция Автоматическая синхронизация времени позволит автоматически подстраивать часы, соединяясь с
удаленным сервером в Интернет. Естественно, чтобы это работало, вам необходимо соединение с Интернет.
Лучше всего выбрать ближайший к вам сервер времени. Эта опция устанавливает на вашу машину сервер
времени, который опционально может использоваться другими машинами в вашей локальной сети.

25



Глава 3. Инсталляция с DrakX

3.15.3. Настройка графического сервера X

X (для системы X Window) это сердце графического интерфейса GNU/Linux, на базе которого работают все
графические среды (KDE, GNOME, AfterStep, WindowMaker, и т.д..), входящие в Mandrakelinux.

Вам будет представлен список различных параметров для получения оптимального графического
отображения:

Видеокарта

Инсталлятор обычно автоматически определяет и настраивает видеокарту, установленную в вашей
машине. Если это не так, вы можете выбрать в этом списке карту, которая у вас действительно
установлена.

В случае, когда для вашей карты доступны различные сервера, с 3D ускорением и без, вам предложат
выбрать, какой сервер больше соответствует вашим потребностям.

Монитор

Инсталлятор обычно может автоматически определить и настроить монитор, подключенный к вашей
машине. Если ему это не удалось, вы можете самостоятельно выбрать ваш монитор из списка.

Разрешение

Здесь вы можете выбрать разрешение и глубину цвета из того, что доступно для вашего оборудования.
Выберите то, что вам больше подходит (вы сможете это изменить после инсталляции). Пример
выбранной конфигурации отображается на мониторе.

Проверить

В зависимости от вашего оборудования, данный пункт
может либо появляться либо отсутствовать.

Система попытается открыть графический экран в выбранном разрешении. Если вы сможете увидеть
сообщение во время проверки и ответить Да, тогда DrakX перейдет к следующему шагу. Если вы не
увидите сообщения, это значит, что часть определенной автоматически конфигурации была неверна
и проверка автоматически завершится через 12 секунд, вернув вас в меню. Поправьте настройки и
проверьте заново, пока вы не получите корректное графическое изображение.
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Параметры

Здесь вы можете настроить вашу машину на автоматическую загрузку в графическом интерфейсе.
Очевидно, что вам следует выбрать Нет, если ваша машина будет работать в качестве сервера или вам
не удалось настроить графический режим.

3.15.4. Настройка сети

Теперь у вас есть возможность настроить ваше соединение Интернет/Сеть. Если вы хотите подключить
ваш компьютер к Интернет или локальной сети, нажмите Далее ->. Mandrakelinux попытается автоматически
определить сетевые устройства и модемы. Если автоопределение не пройдет, снимите выбор с опции
Использовать автоопределение. Кроме того, вы можете не выбирать настройку сети или сделать это позже.
В этом случае просто нажмите кнопку Отмена, чтобы перейти к следующему шагу.

Для настройки сети вам доступны следующие опции соединений: Обычное модемное соединение, Win-
модемное соединение, ISDN модем, ADSL соединение, кабельный модем, и, наконец, простое подключение
к LAN (Ethernet).

Здесь мы не будем подробно останавливаться на каждой опции конфигурации. Просто убедитесь в том,
что все необходимые параметры, такие как IP адрес, шлюз по умолчанию, DNS сервера и т.д. были вам
выданы вашим поставщиком услуг Интернет (Internet Service Provider) или системным администратором.

По поводу Win-модемного соединения Win-модемы это
специальные интегрированные дешевые модемы, которые
требуют для работы, в отличии от обычных модемов,
дополнительное программное обеспечение. Некоторые из
таких модемов уже работают в Mandrakelinux, некоторые нет.
Список поддерживаемых модемов вы можете получить на
LinModems (http://www.linmodems.org).

Вы можете ознакомиться с деталями настройки в главе о соединениях Интернет в книге Стартовое
руководство пользователя , или просто подождать, пока ваша система будет установлена и использовать
описанную в этом руководстве программу для настройки соединения.
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3.15.5. Установка начального загрузчика

Этот диалог позволяет тонко настроить ваш начальный загрузчик:

• Используемый начальный загрузчик: существуют три варианта начального загрузчика:

1. GRUB: если вы предпочитаете GRUB (текстовое меню).

2. LILO с текстовым меню: если вы предпочитаете LILO с текстовым интерфейсом меню.

3. LILO с графическим меню: если вы предпочитаете LILO с графическим интерфейсом.

• Загрузочное устройство: в большинстве случаев вам не прийдется менять значение по умолчанию
(/dev/hda), но если вы желаете, начальный загрузчик может быть установлен на второй жесткий диск
(/dev/hdb), или даже на дискету (/dev/fd0);

• Пауза перед загрузкой образа по умолчанию: во время загрузки или перезагрузки компьютера
пользователю предоставляется возможность выбрать в меню загрузчика отличный от умолчания
вариант загрузки.

• Включить ACPI: ACPI это новый стандарт (появился в 2002 году) для управления питанием, в основном
для ноутбуков. Если вам известно, что ваше оборудование поддерживает его и вам он нужен, отметьте
этот пункт.

• Запретить APIC: Если у вас возникли проблемы с оборудованием машины (конфликты IRQ, нестабильная
работа, зависания машины, ...), вам следует попробовать отключить APIC выбрав этот пункт.

Будьте осторожны при отмене установки начального
загрузчика (нажатие здесь кнопки Пропустить ведет к
этому), потому что у вас должен остаться хотя бы
один способ загрузить вашу систему Mandrakelinux! Также
убедитесь в том, что вы знаете что делаете, когда изменяете
какой-либо параметр.

При нажатии на кнопку Дополнительно появится диалог со
множеством опций для продвинутых пользователей.
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3.15.6. Настройка пунктов начального загрузчика
После того, как вы завершите настройку основных параметров загрузчика, на экране появится список
параметров загрузки, которые будут доступны во время старта.

Если на вашей машине установлены другие операционные системы, они автоматически будут добавлены в
меню загрузки. Здесь вы можете сделать дополнительные настройки существующих параметров, выбрав
Добавить для создания нового пункта; выбрав пункт и нажав Изменить или Удалить для изменения или
удаления. Кнопка Далее-> подтвердит ваши изменения.

Вы можете сделать так, чтобы никто другой не мог
получить доступа к остальным операционным системам. В
таком случае вы можете удалить соответствующие пункты
загрузки, однако, тогда вам будет нужен загрузочный диск,
чтобы загружать остальные операционные системы!

3.15.7. Выбор сервисов, которые загружаются при запуске системы

Этот диалог используется для выбора сервисов, которые должны стартовать при загрузке системы.

DrakX предоставит список всех сервисов, которые доступны при настройках текущей инсталляции.
Пересмотрите их внимательно и уберите все, которые не являются необходимыми для старта во время
загрузки системы.

Вы можете получить короткие пояснения относительно
сервиса, выбрав сервис в списке. Однако, если вы не
уверены, полезен сервис или нет, лучше всего оставить как
было по умолчанию.

На этом этапе будьте предельно внимательны, если ваша
машина будет сервером: возможно вы не захотите запускать
сервисы, которые вам не нужны. Пожалуйста помните,
что некоторые сервисы потенциально опасны для сервера.
В общем, оставьте только те сервисы, которые вам
действительно нужны.
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3.16. Установка обновлений из Интернет

В данный момент установки Mandrakelinux было бы неплохо обновить некоторые пакеты из исходного
релиза. Некоторые баги могут быть уже исправлены и решены проблемы безопасности. Чтобы получить
пользу от этих обновлений, сейчас вы можете загрузить их из Интернет. Нажмите Да, если у вас есть
работающее соединение с Интернет, или Нет, если вы хотели бы обновить пакеты позже.

При выборе Да появится список мест, из которых можно получить обновления. Выберите ближайший
к вам сервер. Затем появится дерево выбора пакетов: просмотрите список и нажмите Установить для
получения и установки выбранных пакетов, или Отмена для отмены.

3.17. Все завершилось!

И вот вы здесь. Установка завершена, и ваша система GNU/Linux готова к использованию. Просто нажмите
Перезагрузка, чтобы перезагрузить систему. Первое, что вы увидите после того, как ваш компьютер
закончит тестирование оборудования, это меню начального загрузчика, предоставляющее вам выбор
какую операционную систему загрузить.
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Кнопка Дополнительно покажет еще две кнопки:

1. Создать дискету автоматической установки:
для создания инсталляционной дискеты, с

помощью которой можно автоматически провести
инсталляцию, подобную только что проведенной,
без участия оператора.

Обратите внимание, что после нажатия на кнопку
доступны два различных варианта:

• Повтор: это частично автоматизированная
установка, в которой только шаг разметки
диска (и только он один) требует участия.

• Автоматически: полностью автоматическая
инсталляция: жесткий диск полностью
перезаписывается и все данные теряются.

эта возможность очень удобна, когда нужно
повторять инсталляцию на большом числе
одинаковых машин. Смотрите раздел Auto install
(http://www.mandrakelinux.com/drakx/auto_inst.
html) на нашем web сайте, чтобы получить больше
информации.

2. Сохранить выбор пакетов: сохраняет выбор
пакетов, сделанный в данной инсталляции.
Для использования своей выборки пакетов для
другой установки, вставьте дискету в дисковод и
запустите установку. В приглашении нажмите F1
и наберите linux defcfg="floppy".

3.18. Как удалить Linux

Операционные системы обычно не предлагают возможности самоликвидироваться. Однако, если у вас
возникла необходимость удалить Mandrakelinux, вы можете это сделать.

Процедура состоит из двух шагов:

1. Удалите все разделы, имеющие отношение к Mandrakelinux на вашем жестком диске (обычно это
разделы с файловой системой ext3 и раздел swap) и, опционально, замените их одним разделом FAT,
используя DiskDrake.

Удаление разделов на вашем жестком диске неизбежно
приведет к потере данных на нем. Убедитесь, что вы
сделали резервные копии всех необходимых данных перед
выполнением этого шага.

2. Удалите начальный загрузчик (в общем случае, GRUB) из Master Boot Record (MBR). Чтобы сделать
это, загрузитесь под DOS и запустите команду fdisk /mbr.

Если у вас другая операционная система, прочитайте документацию к ней, чтобы узнать, как
пересоздать в ней master boot record.

До свидания, и спасибо вам за использование Mandrakelinux!
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Глава 4. Миграция из Windows®/Mac OS X®

Эта глава предназначена для пользователей, которые мигрируют из Windows или MacOS X. Вместо
детального описания различных приложений эта глава попытается дать ответы на обычные вопросы
и/или проблемы бывших пользователей Windows или MacOS X, которые у них обычно возникают.

4.1. Где мои...?

Опытные пользователи Windows или MacOS X привыкли к некоторым функциям и/или принципам,
которые, очевидно, несколько по-иному реализованы в GNU/Linux

4.1.1. Стартовое меню
Эта концепция остается более или менее похожей, кроме того, что теперь оно называется главное меню: в
KDE большое “K” расположено слева внизу вашего экрана.

Пользователи MacOS X, возможно, привыкли к несколько иному. Меню Apple (расположенное далеко
слева от панели меню) не содержит приложений, но предлагает различные сервисы. Обычно приложения
находятся в папке ffl@8;>65=8O в “Finder”.

4.1.2. Приложения
Главное отличие GNU/Linux от Windows –– это наличие огромного количества приложений. Mandrake-
linux инсталлирует гораздо больше приложений в вашу систему, и когда вы зайдете в главное меню,
вы получите богатый выбор приложений, с которыми вы можете работать. Существует множество
полнофункциональных приложений, доступных для выполнения обычных задач, таких, как редактирование
текстов, работа с электронной почтой, просмотр web-страниц и т.д.

Для пользователей MacOS X множество приложений является схожим между MacOS X и GNU/Linux. Так
как MacOS X базируется на BSD, большое количество приложений подобны, а другие приложения для
рабочего стола портированы или имеют X11 реализацию под MacOS X.

Кроме того, вы можете добавить огромное количество приложений самостоятельно при помощи утилиты
RpmDrake .

4.1.3. Панель управления/Настройки системы
Панель управления в Windows и утилита Настройки системы в MacOS X заменяются на Mandrakelinux
Control Center под Mandrakelinux. Найти его можно в главном меню в Администрирование системы→
Настройка компьютера. С помощью этого интерфейса у вас есть возможность изменять основные
системные настройки, используя графические средства.

4.1.4. DOS Shell

GNU/Linux очень любят за его окружения shell. В отличие от Windows или MacOS, популярность shell не
падает. По умолчанию Mandrakelinux устанавливает bash, действительно мощную среду shell. Вы можете в
нее попасть, выбрав Администрирование системы→Использовать эмулятор терминала.

Ваши DOS команды или функции не будут работать в Linux
shell. Обратитесь к разделу Введение в командную строку
книги Справочное руководство, чтобы найти похожие
команды и познакомиться с великим множеством других
команд и утилит. Получайте удовольствие, потому что
теперь у вас есть настоящая shell под руками!
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4.1.5. Сетевое окружение
GNU/Linux использует по умолчанию TCP/IP, а не SMB (сетевой протокол Windows), поэтому здесь не
существует такой вещи, как иконка сетевого окружения, предоставляющая возможность просмотра сети, в
которой вы находитесь. Кроме того, вы можете использовать приложение LinNeighborhood, чтобы получить
похожую функциональность.

Для выполнения подобной задачи вы также можете использовать Konqueror . Просто наберите в панели
навигации: lan:/ для Konqueror или smb:/ для Nautilus, и появится список Windows ресурсов общего доступа
данного сервера. Помните, что для того, чтобы это работало, должен быть установлен пакет samba-client.

4.1.6. Диск C:

Концепция обозначения “дисков буквами” принадлежит исключительно Windows. В системах UNIX
обозначение диска (C:, D:, ..., Z:) заменено на “точки монтирования”. С точки зрения пользователя
вы всегда имеете дело с каталогами. Ваша система будет использовать конфигурационные файлы для
объяснения файловой системе, как “загрузить” все важные диски, разделы диска и удаленные системы,
а затем разместит их в определенных вами каталогах, в общем случае в каталоге /mnt/. Хотя данная
концепция похожа на ту, что используется в MacOS X, она все же несколько отличается. То, что
монтируется в /mnt в GNU/Linux, в MacOS X монтируется в /Volumes, но сделано доступным как “корневая
файловая система” в Finder.

Благодаря таким настройкам GNU/Linux может читать любую другую файловую систему, которую вы
настроили, или даже каталог Windows.

4.1.7. Устройство CD-ROM

Здесь снова применима та же концепция, что и для C:. CD-ROM-ы “монтируются” в каталог /mnt/cdrom/.
Для получения доступа к нему просто нажмите иконку на рабочем столе. Если у вас запущен Nautilus,
CD-ROM появится так же, как новое окно.

К сожалению, это пока не работает с аудио CD. Тем не
менее до вашей коллекции музыки добраться вы сможете.
Посмотрите Аудио, кино и видео приложения в книге
Стартовое руководство пользователя.

4.1.8. Дисковод
Как и CD-ROM-ы или разделы диска, дискеты тоже монтируются, и их содержимое появляется в каталоге
/mnt/floppy. Дискеты, форматированные под Windows, тоже поддерживаются.

Воспользовавшись иконкой Съемные устройства на рабочем
столе, вы получите доступ ко всем вашим съемным
устройствам: дискете, CD-ROM, ZIP и т.д.

4.1.9. Мои документы
В Mandrakelinux у каждого пользователя есть каталог с названием Documents/, расположенный в его
домашнем каталоге.

Концепция “домашнего каталога” похожа на каталоги \winnt\Profiles\user_name\ или \DocumentsandSettings\
user_name\ в Windows NT/Windows 2000/Windows XP .

В MacOS X это выглядит очень похоже. “Домашний каталог” находится в /Users/user_name, и в нем тоже
есть каталог с названием Documents.

Скорее всего, у вас имеется много файлов соответствующих форматов, таких, как документы Excel или
Word. Обычно нет проблем отконвертировать их. OpenOffice.org это только одно из приложений, которое
умеет импортировать множество популярных форматов для офисных приложений.
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Мы специально останавливаемся здесь на офисных
документах, так как офисная работа очень важна. Мы
не можем перечислить здесь каждое приложение под
Windows и его эквивалент под GNU/Linux, это займет
слишком много места. Однако существует большая
вероятность, что вы найдете GNU/Linux эквиваленты для
всех программ, которые вы используете под Windows или
MacOS X. Неплохой идеей будет поискать соответствия
Windows приложениям в этой таблице соответствий
(http://linuxshop.ru/linuxbegin/win-lin-soft/).

4.2. Бравый новый мир!

Теперь, когда ваш путь пролегает поблизости от GNU/Linux, вот вам небольшая презентация его
возможностей, которые мы считаем серьезными причинами для перехода на GNU/Linux.

4.2.1. Многопользовательская среда
GNU/Linux, как и MacOS X, основана на UNIX. Это в основном подразумевает масштабируемость
вашей системы, от простой рабочей станции до многопользовательской архитектуры. Кроме того,
это подразумевает широкие возможности по управлению пользователями. Каждый файл, сервис и
приложение имеет свой уровень доступа для пользователей или групп пользователей в зависимости от
характера использования. Например, каждый пользователь имеет свой собственный “домашний” каталог,
недоступный (и даже невидимый) для других пользователей, в котором содержатся персональные данные
и персональные файлы настроек.

GNU/Linux также предлагает расширенную серверную функциональность, например, возможность размещать
почтовый или web-сервер.

4.2.2. Многозадачность
GNU/Linux всегда была очень сильной операционной системой в плане многозадачности (выполнение
многих приложений одновременно). Хотя другие OS несколько продвинулись в этом направлении,
GNU/Linux остается лидером в этой области.

4.2.3. Несколько рабочих столов
В GNU/Linux, и в KDE и в GNOME, у вас по умолчанию всегда есть четыре (4) рабочих стола вместо одного.
Пользователи, которые предпочитают запускать множество приложений одновременно, по достоинству
оценят эту возможность, которая делает рабочую среду намного удобнее и свободнее.

4.2.4. Полная настройка рабочего стола
С эстетической точки зрения GNU/Linux действительно на высоте! Вы не только можете переключаться
между KDE и GNOME или другими оконными менеджерами; вы также можете тщательно настроить
их внешний вид при помощи “тем”. Темы предоставляют исходный вид: на самом деле все, что вы
видите, можно изменить, от изображения фона до поведения приложения в момент его закрытия, и это
действительно является уникальным.

Зайдите на www.themes.org (http://www.themes.org/), чтобы найти множество различных тем рабочего
стола.
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4.2.5. Тысячи свободных приложений
Безусловно, сообщество GNU/Linux является самым щедрым и продуктивным. Если у вас возникает
специфическая проблема, вы наверняка найдете скрипт или приложение, отвечающие вашим нуждам,
причем свободные! Кроме того, Mandrakelinux включает в себя сотни приложений, не документированных
в этой книге; не стесняйтесь и пробуйте их. Вы наверняка будете весьма удивлены тем, сколько
возможностей предлагает GNU/Linux.

4.2.6. Больше никаких перезагрузок!

Пользователям Windows и старых версий MacOS (хотя более свежие версии MacOS ведут себя гораздо
лучше) знакомо чувство разочарования, которое вызывает падение системы. Даже если GNU/Linux не само
совершенство, ее стабильность является одним из ее сильнейших мест. Иногда приложения падают, но это
редко приводит к падению операционной системы в целом.

Мы надеемся, что этот краткий тур поможет вам реально ощутить силу GNU/Linux. Не бойтесь исследовать
ее подробнее!
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5.1. Введение
Эта глава написана для неопытных пользователей. Если вы умеете создавать иконки на рабочем столе или
размещать окна во всех рабочих областях, тогда пропустите эту главу и отправляйтесь дальше. Если нет ––
читайте! Вы узнаете, как работать с вашей оконной средой, запускать программы и выключать компьютер.
После прочтения этой главы все эти вещи приобретут для вас более глубокий смысл.

Если вы опытный пользователь Windows или MacOS, почитайте раздел Гл. 4, который призван упростить
переход от этих двух OS в GNU/Linux.

Мы предполагаем, что вы сейчас находитесь перед компьютером, на котором запущен и работает Mandra-
kelinux и автоматически отображается графическое окно входа в систему. Если это не так, тогда вы видите
черный экран, на котором отображается что-то типа:

Mandrake Linux release 9.2 (CodeName) for i586

Kernel 2.4.22-9mdk on an i686 / tty 1

machine_name login:

с мигающим курсором. Тогда введите ваше имя пользователя (обычно это ваше имя или ник), затем
свой секретный пароль. Вы должны произвести “вход в систему”. Затем напишите startx, и запустится
графический интерфейс.

GNU/Linux предлагает множество графических интерфейсов. В данном руководстве мы обсудим KDE.

5.2. Меню начального загрузчика
Когда вы перезагрузите свой компьютер после завершения установки Mandrakelinux, первое, что вы
увидите –– это меню, содержащее один или несколько пунктов, которое называется “меню начального
загрузчика”. Оно позволяет вам загрузить вашу систему GNU/Linux, а также любую из ранее установленных
систем, плюс выбрать некоторые специальные опции.

Количество пунктов меню и названия зависят от вашей конкретной настройки. Все, что нас интересует
в данный момент –– это пункт меню с названием linux, по которому запустится Mandrakelinux. Если этот
пункт выбран по умолчанию и вы ничего не меняли самостоятельно, то все, что нужно сделать –– это
подождать несколько секунд, пока идет отсчет времени внизу экрана или нажать Enter, и Mandrakelinux
начнет загрузку. Вы можете выбрать другой пункт меню, если вам нужно загрузить другую операционную
систему, которая, возможно, установлена на вашем компьютере. Для этого нужно переместить курсор
меню на нужный пункт, используя клавиши со стрелками на клавиатуре.

5.3. Приготовьтесь к вашему первому сеансу
Пока ваша система Mandrakelinux загружается и показывает вам некоторую техническую информацию, мы
представим вам фундаментальную концепцию мультипользовательской системы: сеанс.

GNU/Linux –– это многопользовательская система. Это означает, что доступ к одной машине могут
иметь несколько пользователей, и у каждого из них есть возможность сохранять свои собственные
данные и файлы настроек приватными и защищенными от других пользователей. Для того, чтобы это
было возможно, системный администратор должен создать каждому пользователю собственный аккаунт
(учетную запись). Администратор –– это пользователь по имени root, чей пароль был установлен во время
инсталляции, и он имеет доступ ко всем файлам в системе.

Важно также понять, что означает “войти в систему” и “выйти из системы”. Войти означает: идентифицировать
себя перед компьютером. Это аналогично тому, что офицер по безопасности проверяет, кто вы, перед тем,
как позволить вам войти. После вашего входа система проводит некоторый набор действий, направленных
на то, чтобы предоставить вам доступ к системным ресурсам. Входя в систему, вы запускаете так
называемый “сеанс” (сессию, session).

Выйти означает, что вы сообщаете системе о том, что вам больше не требуется использовать систему. Ваш
личный сеанс закрывается, вы выходите из графического интерфейса, и вновь появляется окно входа в
систему.
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Несмотря на то, что эти определения имеют силу в пределах
этой главы, они несколько упрощены. Когда вы прочитаете
следующие главы, вы лучше поймете эти концепции, их
преимущества и опции.

5.4. Начало вашего сеанса

5.4.1. Самоидентификация
Чтобы войти в систему, вы должны знать и предоставить имя вашего логина и ваш пароль. Первое
идентифицирует вас (это обычно ваше имя или ник), а второе –– это ваш ключ, без которого никто не
получит доступа к вашему компьютеру. Если вы самостоятельно проводили установку системы, то у вас
уже должны быть логин и пароль. Если нет, вы должны спросить людей, которые устанавливали систему
на ваш компьютер, чтобы они срочно помогли вам с этим!

Сейчас вы находитесь перед следующим изображением (Рис. 5-1). Конечно, у вас это выглядит несколько
иначе, потому что имена пользователей под значками пингвина, скорее всего, несколько отличаются. :-)

Рисунок 5-1. Окно входа

Процедура входа в систему состоит из четырех простых шагов:

1. Нажмите на иконку, соответствующую вашему логину.

2. Когда появится поле для ввода пароля, введите ваш секретный пароль.

Вы заметите, что символы не появляются в поле, где вы
вводите пароль. Они заменяются на маленькие звездочки
(*), чтобы никто не смог увидеть вашего пароля. Это
обычное для компьютера поведение, где бы вы ни вводили
пароль. Поэтому постарайтесь, несмотря на то, что вы не
видите, что вводите, ввести правильный пароль. Помните:
пароль под GNU/Linux зависит от регистра, а это значит, что,
если ваш пароль выглядит так Very_Secret, а вы напишите
так Very_secret, то вам будет отказано в доступе в систему!

3. Как вы можете заметить, в поле Тип сеанса выбрана по умолчанию среда, которую вы использовали в
прошлый раз. Вы можете выбрать другой тип из выпадающего меню . Если вы входите первый раз,
то есть сразу после установки, среда по умолчанию для вас еще не определена, и вы увидите мастер
Mandrakefirsttime Wizard. Пожалуйста, почитайте Разд. 5.4.2, чтобы узнать больше.
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Рисунок 5-2. Выпадающий список типов сеансов

Этот шаг опциональный и позволяет вам выбрать
специфическую графическую среду. Несмотря на то,
что вам имеет смысл попробовать разные графические
среды, чтобы найти ту, которая нравится больше всего, мы
настоятельно рекомендуем вам начать свой опыт с KDE.

4. И, наконец, просто нажмите кнопку Вход (Login) чтобы начать сеанс. Будьте терпеливы! Подготовка
рабочего стола к работе может занять некоторое время.

Если вы единственный пользователь вашей системы Mandrakelinux и вас затрудняет необходимость вводить
логин и пароль каждый раз при старте нового сеанса, вам будет интересно узнать, что вы можете
пропустить этот шаг и сразу загрузиться в графическую среду предпочитаемого рабочего стола. Эта
возможность известна как auto-login, или автоматический вход и может быть активирована так:

• Запустите Mandrakelinux Control Center, выбрав пункт Администрировать систему→Настроить компьютер
в главном меню или нажмите на иконку Mandrakelinux Control Center на вашем рабочем столе.

• Выберите первый раздел Загрузка, затем щелкните по иконке Drakboot.

• Отметьте опцию Да, я хочу использовать автоматический вход (пользователь, рабочий стол).
Вы должны выбрать пользователя и среду рабочего стола для использования по умолчанию из
выпадающего меню в нижней части окна.

Будьте осторожны при выборе этой опции: так как у вас
в этом случае не спрашивают пароль, ваша система будет
доступна кому угодно. Мы советуем вам использовать
эту опцию, только если ваш компьютер недоступен для
других людей, или если на машине не содержатся важные и
конфиденциальные данные.

5.4.2. Мастер первого запуска
Когда вы впервые войдете в вашу систему Mandrakelinux, вы попадете в Mandrakefirsttime Wizard (Рис. 5-3).
Этот мастер поможет вам настроить большинство основных параметров конфигурации. Мы рекомендуем
пройти все его шаги. Это, возможно, избавит вас от некоторой работы в будущем.

Прежде всего вас попросят выбрать вид вашей рабочей среды из нескольких заготовок. Различные
варианты влияют на то, как файлы, объекты и окна будут отображаться на экране, и как вы будете с ними
взаимодействовать; но важно знать, что они все несут одинаковую функциональность. Таким образом, вы
сможете выполнять одни и те же операции и использовать одни и те же программы независимо от того,
какую графическую среду вы выберете: предпочтение одной перед другой зависит только от вашего вкуса.
Выбор по умолчанию –– это KDE.
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Рисунок 5-3. Мастер первого запуска

Нажмите на кнопку с изображением стрелки внутри поля Выберите рабочий стол, чтобы увидеть
доступные варианты. Некоторые из них предлагают более одного варианта. .

На следующем этапе вы сможете ввести некоторую информацию, необходимую для корректной настройки
ваших приложений для работы с e-mail и группами новостей. Вам необходимо заполнить предлагаемые
поля данными, полученными от вашего поставщика услуг Интернет (ISP).

И наконец, вы можете создать персональный Mandrakeclub аккаунт, который предоставит вам доступ ко
многим онлайновым сервисам, которые предоставляет MandrakeSoft –– таким, как загрузка специального
коммерческого программного обеспечения (полностью автоматическая процедура закачки и установки),
специализированные многоязыковые форумы, возможность голосовать за включение ваших любимых
программ в дистрибутив Mandrakelinux, специальные скидки и многое другое. В ваш пакет Mandrakelinux
включен одномесячный пробный аккаунт для того, чтобы вы могли опробовать множество доступных
сервисов и затем продлить свой аккаунт, если вам понравится (а мы уверены, что это так!).

Кроме того, если у вас уже есть аккаунт в Mandrakeclub, Mandrakefirsttime Wizard поможет вам настроить
вашу систему так, чтобы было легко закачивать и устанавливать специальные обновления с web-сайта
Mandrakeclub, используя непосредственно наш дружественный интерфейс Software Manager. Пожалуйста,
помните, что e-mail адреса и имена пользователей в Mandrakeclub являются уникальными, поэтому вы не
сможете открыть пробный аккаунт, если вы уже являетесь подписчиком клуба. Итак, сделайте свой выбор
и нажмите кнопку Далее, чтобы продолжить.

Как только введение Mandrakefirsttime Wizard закончится, появится ваша новая рабочая среда.

5.4.3. Некоторые заметки относительно безопасности
Важно освоить некоторые принципы безопасности, относящиеся к вашей машине Mandrakelinux:

• никогда не записывайте ваш пароль на каком бы то ни было клочке бумаги (например, на бумаге для
заметок), который могут увидеть другие;

• следите за тем, чтобы ваш пароль был достаточно сложен, чтобы его не смогли отгадать другие, но
достаточно прост для того, чтобы вы могли его запомнить. Попробуйте использовать для вашего пароля
смесь букв и цифр в разных регистрах;
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Неплохой вариант –– придумать какое-нибудь выражение
или фразу, которую вам легко запомнить. Затем взять
оттуда первые буквы и/или цифры каждого слова и
сформировать пароль. Например, из предложения “I was
born on September 10th 1973” можно сделать пароль: Iw-

boS101973, который легко запомнить (все-таки это дата
вашего рождения...) и достаточно трудно подобрать.

• Если у вас непостоянное соединение с Интернет и вам некоторое время не нужно использовать
компьютер, будет неплохо полностью его закрыть, чтобы взломщики не смогли добраться до вашей
машины. То есть, в этом случае вам стоит не просто выйти из системы, но и физически выключить
компьютер (power off). Это можно сделать, нажав на кнопку Выключить (Halt) в окне входа.

Этот список предосторожностей является далеко не полным. Существует множество вещей, которые
можно сделать для более полной защиты вашей системы.

5.5. Использование графической среды
Этот раздел предоставит вам несколько базовых концепций и навыков по использованию вашего
компьютера. .

5.5.1. Рабочий стол Mandrake Linux

Все современные графические среды обладают общим набором возможностей: главное меню, область
рабочего стола с иконками на нем, панель и т.д. В следующих параграфах мы опишем элементы,
составляющие окружение рабочего стола.

Рисунок 5-4. Рабочий стол KDE

1. Слева на экране и внизу вы видите несколько “иконок” (еще их называют значки или пиктограммы).
Иконка - это маленькая картинка, обычно имеющая под собой короткое описание (заголовок или
название иконки), представляющее программу, папку или другой объект, который живет на рабочем
столе: нажав на иконку, вы можете запустить программу или открыть папку. В любом случае, на
рабочем столе появится окно.
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2. В нижней части экрана находится “панель”. Она предоставляет быстрый доступ к полезным
инструментам, таким, как Терминал, система справки и т.д. Каждая иконка символизирует приложение
(или программу). Наведите курсор мыши на одну из них и оставьте его там на пару секунд. Вы увидите,
как появится желтый квадратик, в котором описаны функции иконки.

3. Иконки и панель не плавают по экрану: они как бы “привязаны” к тому, что мы называем рабочий
стол (desktop), , который имеет еще другое название –– “фон (background)”. В этом смысле рабочий
стол –– это то место, где живет все, что мы видим и используем. Перенесите курсор мыши на свободное
место на рабочем столе (то есть место, где нет “ничего”, ни окон, ни иконок) и нажмите правую кнопку
мыши: появится список элементов, который называется “выпадающее меню”, который предоставит
вам доступ к нескольким функциям.

5.5.2. Доступ к программам
Увидев на рабочем столе или на панели слишком мало иконок, вы, возможно, будете озадачены, как же
вам добраться до программного обеспечения, которые установлено в процессе инсталляции. Чтобы это
сделать, найдите первую иконку на панели слева (называемой также “главное меню”):

Рисунок 5-5. Меню приложений для KDE

Щелкните мышью по этой иконке, и вы увидите всплывающее меню со списком программ, которые можно
запускать. Программы организованы по типу выполняемых задач, поэтому найти нужную программу
достаточно просто.

Чтобы запустить приложение или утилиту, щелкните левой кнопкой мыши по иконке в главном меню,
пробегитесь по дереву меню, пока не найдете нужный элемент, затем нажмите на нем левой кнопкой
мыши –– и нужная программа будет запущена. Если вы не уверены насчет функциональности конкретного
пункта меню, оставьте над ним курсор мыши на пару секунд, и вы увидите всплывающую подсказку.

5.5.3. Открытие окна на рабочем столе

Если вы нажмете на иконку на рабочем столе с названием Домой, вы услышите звук работающего
жесткого диска. Затем появится такое окно:
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Рисунок 5-6. Файловый менеджер KDE

Вы только что запустили программу, в данном случае –– файловый менеджер, которая открыла окно и
показывает вам содержимое вашего домашнего (Home) каталога. Этот каталог является тем местом, где
хранятся все ваши личные файлы и документы, доступ к которым имеете только вы. Если вы собираетесь
сохранять много файлов в нем (например, текстовые документы, MP3 файлы и т.д.), мы советуем вам
создавать несколько подкаталогов (например, Documents, Music и т.д.).

Окно состоит из нескольких частей. Вверху расположена строка “заголовка”. В ней показывается название
или заголовок запущенной программы и, возможно, название документа, с которым вы работаете. Она
может находиться в двух состояниях:

• активно, что означает, что вы в текущий момент используете окно, или

• неактивно: программа продолжает работать, но вы в данный момент не производите в ней никаких
действий.

Обычно активные панели заголовков выделены полным цветом, в то время как неактивные становятся
затененными или серыми.

Сразу под строкой заголовка находится “панель меню”. В нашем примере на ней написано (слева направо)
Файл, Правка и т.д. Нажмите на Файл. В выпадающем меню появится список элементов, каждый из
которых предоставляет доступ к определенной функции программы.

Под панелью меню обычно располагается “панель инструментов”. В ней находятся одна или несколько
строк с иконками, которые эквивалентны элементам в выпадающем меню: они предназначены для
быстрого доступа к часто используемым функциям программы.

“Панель состояния” обычно располагается внизу окна. В ней вы найдете информацию о том, что сейчас
делает программа. Не все программы предоставляют эту возможность, однако если какая-либо программа
использует эту возможность, не пренебрегайте изредка поглядывать, что она там пишет.

5.5.4. Управление окнами и рабочими столами
Мы определились с тем, что называется словом рабочий стол , то есть место на экране, где расположены
все объекты (панель, иконки, окна). Теперь рассмотрим панель, расположенную внизу экрана. Вы можете
увидеть группу из четырех “кнопок”:
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Рисунок 5-7. Кнопки виртуальных рабочих столов KDE

Эти кнопки предоставляют вам доступ к виртуальным рабочим столам , которые являются полными
копиями рабочего стола, который вы видите сразу после входа в систему.

Нажмите на кнопку с номером 2: как вы заметили, ранее открытое вами окно исчезло. Не беспокойтесь, вы
не закрыли окно, а просто переключили рабочий стол. Это действие подобно переходу от одного стола к
другому.

Нажмите на кнопку с номером 1. Появится предыдущий рабочий стол.

Эта возможность, называемая “виртуальные рабочие столы” (еще известная как переключатель
рабочих мест), весьма удобна. Она позволяет вам организовывать множество открытых окон, как вам
удобно.

Вы также можете перебрасывать окно с одного рабочего стола на другой. Это может быть очень удобно
для организации вашей работы: например, перенести все окна, относящиеся к работе в сети на рабочий
стол 2, все мультимедийные приложения на рабочий стол 3, и т.д.

Для этого упражнения вам понадобится ваша мышь. В KDE по щелчку правой кнопкой мыши на заголовке
окна появится выпадающее меню, в котором имеется пункт с названием На рабочий стол. Просто зайдите в
этот пункт –– и вы увидите список ваших виртуальных рабочих столов. Выберите рабочий стол, на который
вы желаете переместить ваше окно.

Часто ваше окно может размещаться в правильном месте, но быть слишком маленьким или, наоборот,
слишком большим. Нажмите на эту кнопку в заголовке окна:

Рисунок 5-8. Распахивание окон

Эта операция называется “maximizing” или “распахивание” окна. Нажмите снова на ту же кнопку, чтобы
вернуть окно в предыдущее состояние.

С другой стороны, если вам нужно спрятать ваше окно, но чтобы программа продолжала работать,
нажмите на эту кнопку:

Рисунок 5-9. Сворачивание окон

Кажется, что окно исчезло. На самом деле вы изменили его размер до минимально возможного: до иконки.
Это называется “minimizing” или “сворачивание” окна. Этим самым вы очистили область экрана, которую
занимало окно, но программа продолжает работать. Вы ее видите на панели задач в KDE:
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Рисунок 5-10. Панель задач в KDE

Чтобы восстановить окно на рабочем столе, просто нажмите на иконку, соответствующую вашему окну.

В большинстве случаев вам не нужно будет распахивать или сворачивать окно. Вы можете изменять
размер окна в соответствии вашим нуждам. Это можно делать с помощью мыши и границ окна.

Перенесите курсор мыши в правый край между рабочим столом и запущенной программой.
Вид курсора изменится на двойную стрелку. Теперь действуйте так же, как тогда, когда вы
перемещали окно, нажимая левую кнопку мыши и удерживая ее в процессе перемещения. Окно

изменяет свой размер, и его содержимое перестраивается. Когда размер вас устроит, просто отпустите
кнопку мыши.

Мы произвели это действие с правым краем окна. Вы можете делать то же самое с верхним, нижним
или левым краем окон. Также можно производить эти действия, перемещая углы окна, что приведет к
изменению размеров окна в двух направлениях сразу.

Не всем окнам можно менять размер таким образом:
иногда у окон имеются заранее заданные минимальный и
максимальный размеры.

В качестве заключения разговора о кнопках в заголовке окна рассмотрим следующее:

Рисунок 5-11. Закрытие окна

Если вы нажмете на эту кнопку (кнопка закрытия), вы просто остановите работающую программу: вы
ее прервете, вы из нее выйдете.

5.5.5. Персонализация рабочего стола
Вы можете настраивать по вашему вкусу свою рабочую среду, например фон, цвета окон и фона, “темы”,
поведение окон и иконок и т.д.

5.6. Выход из сеанса
Когда вы закончите изучение графической среды или работу с любимыми приложениями, не забудьте
сообщить системе о том, что вы уходите и произвести соответственно выход из системы.

Выйти из системы можно различными способами. Вы можете использовать главное меню, иконку выхода
или выпадающее меню, появляющееся по правому щелчку мыши. Давайте взглянем на различные
процедуры:
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В KDE

• Используя меню K

Нажмите на K меню и выберите пункт Завершить сеанс [имя вашего пользователя].... Появится
окно такого вида, как показано здесь Рис. 5-12, которое спросит у вас подтверждение.

Рисунок 5-12. Подтверждение выхода из KDE

• Нажатием правой кнопкой мыши на рабочем столе

Вы можете щелкнуть правой кнопкой мыши на “пустом” месте рабочего стола, и появится
всплывающее меню.

Рисунок 5-13. Выход с помощью всплывающего меню в KDE

Нажмите на Завершить сеанс [имя вашего пользователя]..., и появится окно подтверждения.

Какой бы метод вы ни использовали, экран станет затененным и появится небольшой блок с опциями. Если
вы нажмете кнопку OK, будет выполнено действие по умолчанию: вы выйдете из текущего сеанса, после
чего закроются все ваши окна и сам рабочий стол, и вы вернетесь к окну входа в систему.

Как вы, возможно, заметили, есть еще две возможные опции в окне подтверждения: вы можете выключить
систему и отключить питание компьютера (Выключить компьютер в ), или перезагрузить вашу систему
(Перезагрузить компьютер в ). И снова, просто нажмите кнопку OK после выбора желаемой опции.

Каков бы ни был ваш выбор, эти действия являются правильным и безопасным способом выключить
или перезагрузить вашу систему. Никогда не выключайте компьютер просто нажимая кнопку питания,
потому что это может привести к серьезным проблемам с файловой системой и потере данных.
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Кроме руководств, поставляемых с Mandrakelinux, документацию можно получить из многих источников.
Следующие несколько страниц предложат вам несколько советов, которые могут оказаться вам полезными.

6.1. Документация, поставляемая с Mandrake Linux

6.1.1. Собственная документация Mandrakesoft

В этом разделе представлен список всей документации, которая создана MandrakeSoft для текущего
релиза:

• Наши обновленные онлайновые версии ищите на: страницах документации (http://www.mandrakelinux.
com/ru/fdoc.php3).

Если во время инсталляции вы выбрали группу документации, тогда, выбрав в главном меню пункт
Читать документацию, вы найдете всю доступную документацию на тех языках, которые вы выбрали в
процессе инсталляции.

• Стартовое руководство пользователя ;

Это руководство предназначено для того, чтобы глубже познакомить вас с Mandrakelinux. В нем
содержатся основные темы для начинающих пользователей GNU/Linux, а также расширенные инструкции
по процедурам настройки основных элементов.

• Справочное руководство;

Доступное в он-лайн и в Mandrake Linux –– PowerPack ProSuite Edition, данное руководство затрагивает
вопросы расширенной работы в GNU/Linux и системного администрирования.

6.1.2. Страницы руководств (man pages)

Они являются первичным источником получения информации на каждый день. Практически все команды
имеют соответствующие им страницы руководств. Некоторые конфигурационные файлы, функции
библиотек для программистов и другие также имеют свои собственные страницы руководств.

Их содержимое располагается по различным секциям. Ссылки на эти секции сделаны следующим образом:
например, open(2), fstab(5) соответственно ссылаются на страницу open в разделе 2 и страницу fstab в
разделе 5.

Чтобы почитать страницу руководства, напишите man. Синтаксис команды следующий:

man [options] [section] <manual page>

Для самой man доступна команда man man. Страницы руководств форматированы и по умолчанию
отображаются с помощью пейджера less.

Названия страниц руководств и относящихся к ним разделов отображаются в начале каждой страницы.
В конце даются ссылки на другие разделы, имеющие отношение к теме (в общем случае это раздел SEE
ALSO).

Вы можете начать с изучения страниц, относящихся к различным командам, которые встречаются в этом
руководстве: ls(1), chmod(1), и т.д.

Если вы не можете найти подходящую станицу руководства, например, вы хотите использовать в одной из
своих программ функцию mknod, но застряли на странице команды mknod, тогда проверьте, правильно ли
вы указали раздел. В нашем примере: mknod(2). Если вы забыли, как правильно указать раздел, тогда man
-a mknod пробежится по всем разделам и поищет страницы с названием mknod.
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6.1.3. Страницы Info

Страницы info дополняют документацию, включенную в страницы руководств. Команда для доступа к
страницам info это info.

Страницы info имеют древовидную структуру, верхушка которой называется dir. С этого места вы
можете добраться до любой из страниц info.

Страницы info могут вызываться двумя способами: либо опуская любой аргумент, при этом вы попадете в
самый верх древовидной структуры, либо добавлением имени команды или пакета, при этом будет открыта
соответствующая страница, если она существует. Например:

info emacs

В страницах info:

* Buffers::

будет показывать ссылку. Перемещение курсора на эту ссылку (используя клавиши со стрелками) и
нажатие Enter приведет вас к нужной странице info.

Вы можете использовать следующие сочетания клавиш:

• u: это Up (вверх), переместит вас на один уровень выше;

• n: это Next (далее), для перехода на следующую страницу info на том же самом уровне древовидной
структуры;

• p: это Prev (назад), вернет вас на предыдущую страницу info.

• q: это Quit (выйти), для выхода из просмотрщика страницы info.

Список множества команд можно получить, написав “?”.

6.1.4. HOWTOs

HOWTOs, опубликованные проектом TLDP (The Linux Documentation Project) и доступные на многих
языках, помогут вам настроить многие аспекты вашей системы. Если установлены нужные пакеты (пакет
howto-html-en для английской версии), HOWTOs предоставит вам ответы на специфические вопросы или
решения проблем. Документация размещается в каталоге /usr/share/doc/HOWTO/HTML/en/. Это HTML-
файлы, которые можно читать и печатать с помощью любого веб-браузера.

Список файлов HOWTOs весьма внушительный. Советуем ознакомиться с его индексом, зайдя в главное
меню: Читать документацию→Английские HOWTOs. Если вы столкнулись со сложной проблемой,
начните с чтения соответствующего HOWTO (если он существует, конечно!). Вы найдете не только
решение своей проблемы, но к тому же узнаете много нового. Среди других, можно привести такие
полезные документы, как сетевые вопросы (NET-3-HOWTO), настройка звуковой карты (Sound-HOWTO),
запись носителей CD (CD-Writing-HOWTO), а также настройка NIS и NFS и многое другое.

Важным шагом является проверка даты документов HOWTO, то есть даты публикации документа,
которая приводится в начале каждого документа. Это нужно для того, чтобы удостовериться, что
документ еще не устарел. Иначе содержимое документа может быть неверным. Остерегайтесь устаревших
HOWTOs, в особенности касающихся настройки оборудования, так как Linux развивается очень быстро
в этой области. Помните также, что в мире свободного ПО значение “устаревший” имеет значительно
больший вес, чем в области IT вообще: свободное ПО может рассматриваться как устаревшее уже через
две недели после выхода!

HOWTOs доступны в сети на web-сайте TLDP (http://www.
tldp.org/) и там они практически всегда самые новые.
Взгляните также и сюда: HOWTOs , классифицированные
по категориям (http://www.tldp.org/HOWTO/HOWTO-INDEX/
categories.html); и FAQs (http://www.tldp.org/docs.html)
(ЧАсто задаваемые ВОпросы).
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6.1.5. Каталог /usr/share/doc

Некоторые пакеты поставляются со своей собственной документацией, которая хранится в одном из
каталогов, названном по имени пакета, в каталоге /usr/share/doc.

6.2. Интернет
Информационные ресурсы Интернета велики и web-сайтов, посвященных GNU/Linux и ее использованию
или настройке великое множество. Тем не менее, приведем некоторые полезные места:

Вашим основным источником информации должен стать официальный web-сайт Mandrake Linux (http:
//mandrakelinux.com/). В особенности стоит посетить раздел поддержка (http://mandrakeexpert.com).

6.2.1. Web-сайты, посвященные GNU/Linux

6.2.1.1. MandrakeClub

Если вы знакомы с web-сайтами Mandrakelinux, вам, возможно, известен Mandrake Club (http://
mandrakeclub.com/). Это место встречи всех пользователей Mandrakelinux. Здесь вы можете найти
предложения, вопросы, а также новости, относящиеся к Mandrakelinux и GNU/Linux. Вы сможете высказать
свое мнение и повлиять на будущее разработки Mandrakelinux. Если вы еще не вступили в клуб, мы
приглашаем вас это сделать.

6.2.1.2. Демо и учебные пособия

Особый раздел web-сайта Mandrakelinux посвящен многочисленным демо и учебным пособиям (http://
www.mandrakelinux.com/en/demos/). В них обсуждаются, среди других тем, инсталляция и графическое
окружение, множество аспектов настройки системы. таких, как сеть, управление пакетами, конфигурация
сервера и т.д. Некоторые из учебных пособий поставляются на инсталляционном CD в каталоге tutorial.

6.2.1.3. Web-сайты, посвященные вопросам безопасности

MandrakeSecure (http://www.mandrakesecure.net/)

Собственный web-сайт MandrakeSoft, посвященный вопросам безопасности, на котором размещается
информация о уязвимых местах в пакетах, а также множество статей на различные темы, такие как
использование GnuPG, SSH, и многое другое.

Security Focus (http://www.securityfocus.com/)

Хорошо организованный сайт, на котором рассмотрены текущие атаки, дает советы по решению
проблем уязвимости для необыкновенно большого числа продуктов, включая и Mandrakelinux.

Linux Security (http://www.linuxsecurity.com/)

Этот сайт, полностью посвященный Linux, включает новости, советы, рассылки новостей, а также
множество ресурсов, таких как документация, форумы, утилиты и т.д. Ознакомьтесь со страницей
документации (http://www.linuxsecurity.com/docs) этого сайта.

Linux dot com (http://www.linux.com/index.pl?section=documentation)

Отличный сайт, регулярно предоставляющий статьи на тему вопросов безопасности. Главная страница
Linux dot com (http://www.linux.com) также богата статьями по вопросам рабочего стола, звука и
т.д.

6.2.1.4. Другие Web-сайты Linux

Наиболее всесторонние из множества существующих web-сайтов:
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Linux dot org (http://www.linux.org/)

Один из первых сайтов о Linux, который имеет множество ссылок на другие полезные сайты.

Freshmeat (http://freshmeat.net/)

Это место, где стоит поискать свежие приложения из мира Linux.

Linux Weekly News (http://www.lwn.net/)

Наиболее обширные публикации на тему Linux. На нем есть все, от последних сообщения о
дырах в безопасности до новых дистрибутивов, информация о текущем и прошлом ядрах, книги и
еженедельные рассылки новостей.

И, конечно же, не забывайте про свои любимые поисковые системы. Они являются, в общем, наиболее
практическим средством поиска информации. Несколько правильно подобранных ключевых слов в
поисковой системе часто приводят к нужным ответам на вашу специфическую проблему. В Google вы
даже можете провести ориентированный на GNU/Linux поиск, зайдя по этому адресу Google dot com slash
linux (http://www.google.com/linux).

6.2.2. Списки рассылок
Списки рассылок до сих пор являются очень популярными в противовес остальным средствам общения.
Практически каждая GNU/Linux программа имеет свой собственный список рассылки, в котором принимают
участие пользователи, разработчики, ведущие и т.д.

Проект Mandrakelinux имеет свои собственные списки рассылки (http://www.mandrakelinux.com/ru/
flists.php3).

Здесь мы не может привести вам все адреса, но возьмите на заметку, что очень часто имеет смысл
пообщаться с экспертами в конкретной области. Тем не менее, дадим несколько советов:

• не посылайте вопросов, которые не относятся к теме (off-topic). Внимательно читайте правила, которые
вам высылаются при подписке на список рассылки или которые размещены там, где вы нашли адрес
списка. Также рекомендуем прочитать эту версию Этикета E-mail (http://www.iwillfollow.com/
email.htm), еще известного как Netiquette, где приведены некоторые драгоценные советы. Если у вас
достаточно времени, вы можете почитать соответствующий RFC (http://www.rfc-editor.org/).

ВАЖНО: не забудьте всегда хранить первое письмо,
полученное от списка рассылки, так как в нем нормальным
языком объясняется как отписаться, если вам это будет
необходимо;

• придерживайтесь общих правил, применимых к e-mail: в частности, не посылайте сообщения в HTML:
только в текстовом виде;

• списки рассылок обычно имеют архивы: сначала ознакомьтесь с ними! Возможно ваш вопрос уже
обсуждался прежде, чем вы подписались на список рассылки;

6.2.3. Группы новостей
Перед тем, как задавать вопрос в группах новостей (newsgroups), будет полезно поискать, не была ли в
обсуждении (или решена) ваша проблема ранее на Dejanews (http://groups.google.com/googlegroups/
deja_announcement.html), принадлежащем Google. Если не нашлось ничего, что бы относилось к вашей
проблеме, обратитесь к группе новостей, посвященной Mandrakelinux (news:alt.os.linux.mandrake). Вы
также можете присоединиться к множеству других групп в “иерархии” comp.os.linux.*:

• comp.os.linux.setup (news:comp.os.linux.setup): вопросы настройки Linux (устройства, настройка
приложений) и решения разнообразных проблем.

• comp.os.linux.misc (news:comp.os.linux.misc): все, что не вошло в другие группы.
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• и другие...

Перед тем, как посылать вопрос в одну из этих групп, убедитесь, что вы закончили домашнюю работу и
прочитали документацию по теме вашей проблемы. Если это не так, то скорее всего вы получите такой
распространенный ответ: RTFM. И больше ничего!

6.3. Общие принципы решения проблем под Mandrake Linux

Представляем вам несколько различных способов поиска решений проблем. Испробуйте сначала первый
совет, и только тогда, когда это не помогло, переходите к следующему и так далее.

6.3.1. Поиск в Интернет
Различные Интернет сайты, упомянутые выше, являются неплохой отправной точкой. Они имеют дело с
общими и весьма специфическими аспектами вашей потенциальной проблемы. В конце концов, попробуйте
поискать на поисковой системе, например Google (http://www.google.com) или на описанной выше
поисковой системе Linux-specific (http://www.google.com/linux) Google. Не пренебрегайте возможностью
Расширенного поиска (http://www.google.com/advanced_search), где можно детализировать запрос,
например указать полученные вами сообщения об ошибках.

6.3.2. Архивы списков рассылок и групп новостей

Предыдущие поиски могут привести вас к общим ответам, в которых скрыт, среди других, ответ на ваш
вопрос. Вот что вам следует сделать, чтобы уточнить ваш запрос.

Сначала попытайтесь найти список, который более всего подходит под вашу проблему и произведите поиск
в архивах этого списка.

Пример
Вы обнаружили странное поведение при попытке использования GRUB с разделом minix.

Поиск с использованием ключевых слов “grub mailing list” на Google выдает в третьей строке результата
ссылку на архивное сообщение GRUB mailing-list July 1999 (http://mail.gnu.org/pipermail/bug-grub/1999-July/
003129.html). Зайдя сюда вы получите URL корня архива: GRUB mailing list archive (http://mail.gnu.org/
archive/html/bug-grub/). Такой совет дает и сама поисковая система. Таким образом, поиск слова “Minix”
приведет вас к решению проблемы.

Имейте в виду, что не все архивы имеют встроенную поисковую систему. Однако, например, в Google,
вы можете просто использовать поле расширенного поиска domain, чтобы ограничить поиск конкретным
сайтом, содержащим архив. Эту стратегию можно использовать для исключения сайтов, которые продолжают
выдавать вам “мусор”.

Для поиска в группах новостей на Dejanews (http://groups.google.com/googlegroups/deja_announcement.
html) содержатся архивы поразительного количества новостных каналов.

6.3.3. Вопросы в списки рассылок и группы новостей
Смотрите соответствующие разделы выше: Разд. 6.2.2 и Разд. 6.2.3. Отлично помогает чтение How To Ask
Questions The Smart Way (http://www.tuxedo.org/~esr/faqs/smart-questions.html) (Как правильно
задавать вопросы).
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6.3.4. Прямой контакт с ответственным лицом
Используйте эту возможность только в крайнем случае и в исключительных ситуациях, если только вы не
хотите предложить сотрудничество! Разработчики ПО постоянно получают горы почты. Следовательно,
мучающий вас вопрос о том, как использовать команду cd, будет, мягко говоря, просто проигнорирован!

Адреса можно найти на домашних страницах проектов или в документации к ПО.

И напоследок: не стоит недооценивать умений ваших соседей или тех, кто принадлежит к вашей
локальной LUG (Linux Users Group (Группа пользователей Linux)). И, пожалуйста, не бросайтесь вашим
компьютером в окно. Если ваша проблема еще не решена сегодня, то завтра все может измениться...

6.3.5. Бизнес услуги Mandrake

Наконец, если вы попали в действительно трудную ситуацию, особенно если вы корпоративный пользователь,
вы можете нанять одного из консультантов MandrakeSoft для решения вашей специфической проблемы.

Одна из наиболее ошеломляющих возможностей продуктов open-source: имея исходники, мы имеем силу!
Следовательно, практически любая проблема, независимо от степени сложности, специфики или уровня,
может быть решена непосредственно в недрах программного обеспечения.

Возможно, вам станет необходимо настроить вашу среду Linux под узкопрофильные задачи. К примеру,
вы можете использовать Mandrake Linux как сервер роутинга на особых устройствах. Знайте, что в этом
вам могут помочь консультационные услуги MandrakeSoft (http://www.mandrakesoft.com/products/
business).

52

http://www.mandrakesoft.com/products/business
http://www.mandrakesoft.com/products/business


Глава 7. Internet

7.1. Browsing the Web

7.1.1. Konqueror’s Web Browser Interface

You can launch the Konqueror web browser by clicking on this icon in the panel or by selecting
Internet+Web browsers→Konqueror from the main menu.

Рисунок 7-1. Konqueror as a Web Browser

Tool bar. Where all buttons to navigate and perform common actions are located (see Разд. 7.1.2).

Location Bar. Where you enter a site’s URL (or a local file using file:// as the protocol part of the URL).

Bookmarks Bar. It contains buttons which give you quick access to your bookmarked (favorite) sites.

Page Display Area. Where the contents of the web sites and local files you browse are displayed.

7.1.2. Surfing the Web

The following table summarizes the most commonly used navigation buttons Konqueror’s web browser pro-
vides.

Button Keyboard Shortcut Function

Alt-left_arrow

Go back. Returns to the page visited before the current one. By
clicking on it more than once, you can go back more than one page,
but some pages use automatic redirection so this might not always
work. Keeping this button pressed (or clicking on the little black
triangle on its right) will show you a list of all the URLs you can
access through this feature.

Alt-right_arrow Go forward. Returns to the page visited after the current one being
visited. The same back-button considerations apply.
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Button Keyboard Shortcut Function

F5

Reload. Refreshes the current page. By default, Konqueror will first
look for the page in the browser’s cache (on-disk temporary
storage space) and use the local copy. Press the Shift key while
clicking on the reload button to force Konqueror to fetch the page
from the Internet.

Esc

Stop. Aborts transferring the currently requested object and will
therefore cancel the page currently being loaded. Notice that we
use the word “object” instead of “page”. This is due to the fact that
web pages are not only HTML code but images and maybe other
media too.

Таблица 7-1. Konqueror’s Web Browser Tool Bar Buttons

7.1.3. Managing Bookmarks

Bookmarks store the URLs of your favorite web sites so you don’t have to type their address again when you
want to access them. You can classify them by subject, category, etc. Your Mandrakelinux system already has
some bookmark categories predefined which you can use as a guide to arrange yours. Selecting Bookmarks→
Edit Bookmarks from the browser’s menu will open the bookmarks manager shown in Рис. 7-2.

Рисунок 7-2. Konqueror’s Bookmarks Manager Dialog

Bookmarks are arranged as a tree, with all operations taking place on the currently selected tree node. The
following operations are available:

• Create Folder. Click on this button, or select Insert→Create New Folder... from the menu to create a
new folder. A dialog will pop up asking you for the folder’s name: fill it and click on the OK button. Use
folders to group bookmarks by subject, category, etc. Keyboard shortcut: Ctrl-N.

• Create Bookmark. Click on this button, or select Insert→Create New Bookmark from the menu to
create a new bookmark entry. A new entry will be added below the current node or inside the current
folder. Double-click on the URL column at the bookmark’s row, type the bookmark’s URL and press the
Enter key to set the bookmark’s URL. Proceed the same way, but this time on the Bookmark column to set
the bookmark’s name.

• Delete Object. Click on this button, or select Edit→Delete from the menu to delete the currently
selected object: either a bookmark, a separator or a folder. You won’t be asked for confirmation, the object
will be deleted immediately. Keyboard shortcut: Del.
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• Insert Separator. Select Insert→Insert Separator from the menu to add a separating line below the current
node. Keyboard shortcut: Ctrl-I.

• Rename. Right-click on a bookmark or a folder and select Rename to change the bookmark’s name. The
bookmark’s name is the text which is displayed in that bookmark’s entry. Keyboard shortcut: F2.

• Change URL. Right click on a bookmark and select Change URL to change the URL the bookmark points to.
You will be able to edit the bookmark’s URL column, make your changes and press the Enter key to change
the URL. Keyboard shortcut: F3.

Bookmarks can be exported to different browser formats. Feel free to explore the File→Export menu. A stan-
dard dialog will pop up asking you for the bookmark’s file name (for example bookmarks.html for Mozilla).
Type the file name and click on the Save button. Some export entries may not pop up the said dialog. In those
cases, bookmarks will automatically be exported to a location dependent of the browser format.

Bookmarks can also be imported from different browser’s formats. Feel free to explore the File→Import menu.
A standard dialog will pop up asking you for the bookmark’s file name. Browse the dialog for the file, select
it and click on the Open button.

Both export and import file dialogs are “intelligent”, in the sense
that they’ll start from the directory and will show the file types
that best fit the menu entry you’ve selected.

Once you’re satisfied with your changes, click on this button or select File→Save from the menu to
store the new bookmarks. Keyboard shortcut: Ctrl-S.

7.1.4. Tabbed Browsing

Рисунок 7-3. Konqueror’s Browser Tabs

Konqueror’s web browser lets you browse many web pages at a time by using a very nice feature called tabbed
browsing. Instead of opening a new browser window every time you want to view another page you can
open a new tab.

Clicking on this button in the tool bar, or choosing Window→New Tab from the menu will create and
open a new tab. You can now input the URL or select a bookmarked site to browse that site. Keyboard shortcut:
Ctrl-Shift-N.

Clicking on this button in the tool bar, or choosing Window→Close Tab from the menu will close the
currently displayed tab. Click on a tab’s title to display the contents of that specific tab. Keyboard shortcut:
Ctrl-W.

Right-click on a tab’s title and select Close Other Tabs to close all tabs except the one currently displayed.
Right-click on a page’s link and select Open in New Tab to open that link in a tab, but not displaying that tab
immediately. This last feature is very handy to open several linked sites at the time “to look at them later”
without leaving the site you are currently browsing.
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7.1.5. Konqueror Web Browser and Plugins

Рисунок 7-4. Plugins Settings under Konqueror

Plugins are programs which let your browser handle content other than HTML and graphics, such as anima-
tions, streaming audio, Java applets, and more. Konqueror uses Mozilla and netscape plugins. Select Settings→
Configure Konqueror... from the menu and open the Plugins section to set Konqueror’s plugins’ preferences (see
Рис. 7-4).

After you’ve (optionally) downloaded and installed the corresponding plugins, click on the Scan for New
Plugins button to have Konqueror recognize and set up the installed plugins: all directories listed in the Scan
Folders list will be searched for.

You can view which plugins are set up in the Plugins tab. By default, only the Netscape Plugins (which gives
Konqueror access to Mozilla’s and netscape’s plugins) is installed. Once you’re satisfied with the settings, click
on the OK button to make them effective.
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